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Do not connect the USB HASP key to the 
computer till installation is completed. After 

installation is finished, connect the key.

A. Installation of CephaloMetrics 
AtoZ
Insert CD-ROM into a computer. Installation begins 
automatically.

※ When installation menu is not displayed automati-
cally, double-click "setup.exe" and install it.There is 
the file in "Disk1"  in "(G:)CD-ROM". (G:) shows the 
drive that CD was inserted in. This process depends 
on your environment. 

1. The following window appears.
Click the "Next" button.
　

　

2. Click the "Next" button after the confirmation.

　

3. Click the "Next" button.

　

Installation starts.

　

Click the “Close” button.

　※ Installer of Windows was changed newly from 
AtoZ Ver.11. Therefore a method of the installation 
changes. When you install a driver for protection 
keys, you cannot install the key driver from installa-
tion of AtoZ successively. If installation of AtoZ is fin-
ished, you click “Start”menu → ”All programs“ → 
”CephaloMetrics AtoZ“ → ”Install HASP key driver“. 
And start the installer of a driver for protection keys.

B. Installation of driver software for 
protection key

1. If installation of AtoZ is finished, you click “Start”
menu → ”All programs“ → ”CephaloMetrics AtoZ“ 
→ ”Install HASP key driver“. And start the installer 
of a driver for protection keys.

Installation of CephaloMetrics AtoZ for Windows XP
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Even if you connect the protection key, a computer 
doesn't recognize it.

1. Click the “Next” button in the “Welcome” window.

2.Check the “I accept the license agreement” but-
ton in the window, click the “Install” button.

　　

3. Click the “Next” button.

　　

4. Click the "Finish" button.

　　

5. After connection the protection key, start Cepha-
loMetrics AtoZ ！
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Do not connect the USB HASP key to the 
computer till installation is completed. After 
all installation, connect the key.

A. Installation of CephaloMetrics AtoZ

Insert CD-ROM into the computer. CD-ROM icon 
appears on the desktop.
Double-click it, and open the CD-ROM. The follow  
window is indicated.

 　 

 Make the  “CephaloMetrics AtoZ” folder. And copy 
all file on this folder. 

B. Installation of driver software for 
protection key

1. In the same way, copy "HASP4 Driver" folder →”
Sentinel_HASP_RTE_Installer”folder in CD-ROM  to 
the arbitrary place of the computer.

2. Double-click of copied "Sentinel_HASP_RTE_
Installer" folder, and open it.

  

3. Double-click of copied “Sentinel_HASP_RTE_
Installer.dmg" , and open it.
3. Installer of the driver starts when you double-click 

of “Install HASP SRM Runtime Environment” of the 
inside.

Install it according to indication of the screen.

4. After all installation, connect the protection key in 
USB port of the computer. You can start Cephalo-
Metrics AtoZ.

  　

Installation of CephaloMetrics AtoZ for Macintosh OS X
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CephaloMetrics AtoZ  an easy manual
       ＜ Let's try to use AtoZ!  Basic edition ＞

◎ X-Ray Resolution

After installation, Set the resolution of the X-rays image(Thumbnail input). 
Choose "IO setting" → " X-Ray resolution", and Set resolution. Input horizontal and vertical resolution (dpi) 
values, and click the “OK” button.
※ If you input  resolution values once, the values are stored in a computer. You don’t have to do it again.
※ The resolution values vary according to a X-ray machine maker and the model. For details, please contact 
contact with the X-ray machine maker.

When X-rays device is digital, you input digital resolution as follows.
When film X-rays, you input digital resolution as follows.

1. Input X-rays

※ Please refer to「◎ Import an X-ray with the New tool」, when you input directly from a scanner. 
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The thumbnail dialog box appears.
・Click the "Folder" button.

The “Folder” dialog box appears.
・Choose the folder to save images. 
・Choose an image, and click the "open" button.

All of color photos in the folder appears from the 
thumbnail list.

When you change X-rays and a color photo, you click 
“X-Ray” button or “Photo” button.

You can import the respective appropriate images from 
the displayed thumbnail images to the specified frame 
in the AtoZ by dragging and dropping.

◎ Import an X-ray and image with the Thumbnail tool

You can import JPEG files with the thumbnail tool.
・Click the Thumbnail tool.

It becomes the screen which regulates an image when you 
double-click.
・You regulate the size of the image in a blue rectangle frame.
・You regulate the degree of leaning of the image with a blue 
horizontal line.
・If adjustment is over, You click "OK".
・For X-rays picture, click "image resolution" button. 
 Input the value of resolution (DPI) and Click "OK" button. 
※ It is unnecessary when having set up by "IO setting" → "X-Ray 

resolution".
※ If you input  resolution values once, the values are stored in a com-
puter. You don’t have to do it again.
※ The resolution values vary according to a X-ray machine maker and 
the model. For details, please contact the X-ray machine maker.
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1.  Click the New tool.

・Start up AtoZ. 
・ Click the New tool button, when you input a patient's data for the first time. 
AtoZ displays the dialog to input as shown below.
Note : After inputting a X-ray image, or color image, use the Add tool  to input additional im-
ages to a file.

2. Import a CephaloMetrics lateral X-ray image on a scanner with a 

transparent unit.

・Turn on the [Scanner] radio button in the "X-Ray Input Source"dialog box .
・Click the "Select Twain", and choose the Twain of the scanner. 
・Click the "Lateral" X-ray image button.

※ You must install the scanner driver in advance.

◎ Import an X-ray with the New tool
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・Set a lateral X-ray image on a scanner with a transparent unit as below. 
( EPSON ES-2200)

　Setup example for EPSON ES-2200

 
Manuscript type : transparent unit-positive film
Image type : 24bit color (standard)
Output machine : screen / WEB
Resolution : 144 dpi
Manuscript size : 1024 × 936 Pixel
Output size : 1024 × 936 Pixel
Zoom : 100 ％

・Choose t he " t r an spa r en t 
unit"and "positive film", and then 
click the "preview" button.

If you have setup data, click a 
"setting preservation" button. 
Then it appears.

If not, we recommend that you 
should save a setup data refer-
ring to the following example.

The Scanner Twain driver starts. (ex: EPSON ES-2200)

・Adjust the position, by dragging an 
inner area of a frame  displayed on a 
preview screen to import with a mouse.
・And then click the "scan" button.

※ You must choose a zoom (magnifi-
cation) "100%". If not,  distance mea-
surements will be incorrect.
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 ◎ When you import a JPEG file in a digital X-ray machine.

CephaloMetrics AtoZ can import a JPEG file in a digital X-ray machine. However, a JPEG file doesn't 
have size information originally.
Therefore, even if you import it into AtoZ, you can’t evaluate the distance measurements correctly.

So, we equipped "JPEG Digiceph" button with AtoZ to solve the problem. With this button, 
you can import JPEG files easily and free-fiddly to analyze.

１. Import a JPEG file with X-ray image into AtoZ

・Turn on the [Image File] radio button 
in the "X-Ray Input Source"dialog box 
.
・Click the "Lateral" X-ray image but-
ton.

2. Specify image folder. 
Click the JPEG file to import, and click the "Open" 
button.

3. After the dialog box appears, 
click the "Image Resolution" 
button.
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5. Adjust the frame to import, and click the 
"OK" button.

※ You should adjust the frame  to the area 
to be able to input analysis points. (It is a 
standard to import a frame following the 
left figure.)

6. The JPEG file has been imported to 
AtoZ.

4. Click the "Custom" radio button, input horizontal and vertical resolution (dpi) values, and click the "OK" 
button.
※ If you input  resolution values once, the values are stored in a computer. You don’t have to do it again.
※ The resolution values vary according to a X-ray machine maker and the model. For details, please contact 
with the X-ray machine maker.
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2. In the next step, digitize points and lines to the imported lateral X-ray 
image.

A guidance window appears when you check the "Input Guidance" in I/O Setting menu in advance.
And, you can use a voice guide by a computer together when you check the "Input Sound" in the I/O 
Setting menu.

Guidance window

 Bit of advice

When you click the magnifying tool,  a whole X-ray image is expanded.  Moreover, when you click the 

point you want to see in detail , you can obtain the magnified part of image.

You can reduce it adversely.

When you choose the Hand tool  and drag the image, you can move the image.
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◎ How to use an image enhancement function

Image enhancement is the processing treatment to give better viewing with shade treatment using 
digital techniques of a computer in the X-ray image .

When you click the Enhance tool button  in the Tool window, the Enhanced window appears. You 
can adjust the image as you like. To close the window, click the button again.

(1) Partial image Enhancement

・Click the Frame tool , drag the desired area  in a X-ray image with the mouse,  and 
surround it.
・Click each item in the Enhance tool window to adjust the image.
※ When you specify an area with the Frame tool, you should not surround a dark part and 
a light part at the same time. To work the enhancement function properly, it is important that 
there isn’t so much shaddock difference in the specified area.

(2) Whole image Enhancement

・Click each item in the Enhance tool window without specifying an area with the Frame tool.

the Enhance too l 
window
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　  For the details of each item in the Enhance tool window, please see below.

To disable all history of the filter processing and return to the former 
image.
To cancel the last filter processing.

To surround the desired area to enhance.

To give the "Smooth" effect to an image.

To give the "Soft" effect to an image.

To give the "Sharp" effect to an image.

To give the "Embossed" effect to an image.

To enhance an image with shading process.

To display the "Custom Filter" menu.

To display the "brightness and contrast" menu.

To invert negative-positive image.

To reverse right and left image. To reverse top and bottom, click it 
while holding the control key.

"brightness and contrast" menu

Attention!
After enhancing a X-ray image, just save it. If you want to save an image before enhancement, click 

the "Restore tool"  and save it, and you should return it to the initial state before enhancement.
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・Click the Tracing tool  on the upper-right corner of a screen, and input points and lines 
on a display. 
There are two kinds of methods to input: a normal digitizing a trace and a Template Input.

＜ Digitizing a Trace normally ＞
For lateral analysis, make sure to input all 32 points starting at [Sella], and 4 lines in order. 
You can’t skip it usually.

　　・Click the left button to input a point with a mouse. (Click a mouse to input a point: 	
	 Macintosh)
　　・Left-drag to input a line with a mouse. (Drag to input a line: Macintosh)

※ To turn back a point, hold a Shift key and click it.

　　・Shift key + click a Left button.  (Windows)

　　・Shift key + click a mouse.  (Macintosh)    

When the fourth line [Maxillary line] input is done, [Line] appeaars on the screen, and it is suggested 
that you should input a line more.
If necessary, you can input the shape of the "Sella" and others additionally. 

・Click the Arrow tool  to terminate a digitizing session.
・Terminate the points and lines input, and go to the "Patient I.D." input.

　  　　

 (You can turn back a point as much as you clicked.)  
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◎ About  "Template Input"
When you input three points of Porion, Orbitale and Gnathion in order, the rest of the analysis 
points are scattered automatically in approximate positions. And correct  each point by drag-
ging with a mouse.
※ When you want to input more quickly, uncheck the "Input Sound" in the I/O Setting menu, 
to set a voice guide function unworking.

When the "Template Input" 
sets up.

Confirm that there is a check mark at the side of the "Template Input" 
in the I/O Setting menu.
If not, click the "Template Input".

・When you click the “Tracing” tool in the Trace tool window, it enters an 
analysis point digitizing mode. 

To decide a Gnathion point, use the "Bisector" tool.
・Click the Bisector tool in the Trace tool window, and obtain the side of the 
Gnathion position.

How to use the "Bisector" tool
When you click the Bisector tool, a computer asks you to input the "Point1" 
first.

case of “FH-3Points Input”
・Input three points of Porion,  Orbit-
ale and Gnathion.

Chooses the input method of the template.
・Advance "IO setting" → "Lateral Tamplate Input Setting".
・Choose it among "FH-3Points Input" or "SN-2Points Input".
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・Input each 4 points.
　　Point1：Corpus
　　Point2：Menton
　　Point3：Nasion
　　Point4：Pogonion
Then bisectors appear . The point that the lines 
intersect is a Gnathion.

・Click the Tracing tool again. 
・When you input a Gnathion, the rest of the analysis points appear automatically.

When you point the cursor to the point to correct with a mouse, the name appears on the screen 
and announce with computer voice.
Just as it is , drag it to fine-tune the position. The tuned analysis points color change from red to 
blue. You can correct it starting with any points or in any order.
After that, digitize the lines. The way of input lines is the same as the normal input.

The entered points appears in blue , and 
the automatic displayed points appear in 
red.

・Correct the red points appeared in  a 
wrong position.

1

2

3

4

case of “SN-2Points Input”
・Input two points of Sella and Nasion.
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Location of 32 lateral landmarks
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 1. Sella 			  : Sella, A constructed point in the middle of the sella turcica.
 2. Porion		  : Anatomy Porion、Most superior point of external auditory meatus
 3. Basion		  : Most inferior point of external auditory meatus
 4. Hinge Axis		  : Center of Condyle
 5. PT-point		  : 11 o'clock position of the pterygoid fissure
 6. Nasion		  : 'V' notch of frontal and nasal bone
 7. Orbitale		  : Orbitale, Most inferior point of the orbital contour
 8. ANS			   :Tip of the Anterior Nasal Spine
 9. PNS			   :Tip of the Posterior Nasal Spine
10. A-point		  :Deepest point between ANS and the upper incisal alveolus
11. B-point		  :Deepest point between Pogonion and the lower incisal alveolus
12. PM			   :Point where curvature changes between B-point and Pogonion
13. Pogonion		  :Most anterior point of the symphysis
14. Gnathion		  :on the born Gnathion, gnathion is the point of intersection of facial and mandibular 		
			   planes.
15. Menton		  :Most inferior point on the synphyseal outline
16. Corpus		  :the point of a tangent of the inferior border of the corpus; mandibular plane left
17. Gonion		  :the intersection of the lines tangent to the posterior margin of the ascending ramus and 	
			   the mandibular base.
18. Ramus down		  :Lower point of a tangent of the posterior border of the ramus
19. Articulare		  :Intersection of inferior cranial bas 〜 surface and posterior surface of condyle
20. Condylion (Co)	 :It is the most superior point on the condylar head.*
21. R3			   :Most inferior point of the sigmoid notch of the ramus
22. R1			   :Deepest point on the curve of the anterior border of the ramus
23. Mx1 crown 		  :Tip of the crown of the upper incisor
24. Mx1 root 		  :Tip of the root of the upper incisor
25. Md1 crown 		  :Tip of the crown of the lower incisor
26. Md1 root		  :Tip of the root of the lower incisor
27. Occlusal plane	 :Midpoint between upper and lower first bicuspid, or upper and lower incisor
28. mx6 distal		  :Distal contact point of maxillary first molar 2 mm above occlusal plane
29. mx6 root		  :Distal buccal root of maxillary first molar
30. md6 distal		  :Distal contact point of mandibular first molar 2 mm below occlusal plane
31. md6 root		  :Distal root of mandibular first molar
32. PAC			  :Dr.Kim's PAC (Posterior Alar Cartilage),use for ODI, APDI palatal plane instead of ANS-	
			   PNS palatal plane.

32 landmarks of the lateral analysis
　Following is a list of the 32 landmarks required for a lateral analysis, together with their exact defini-
tions.

Lines for the lateral analysis

  1. Upper profile Line
  2. Lower profile line
  3. Mandibular Line
  4. Maxillary Line
  5. Other structures 
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Line input of lateral and hard tissue.
You click "Arrow tool" and, after point input, move to line input next. 
Input a point along guidance when you choose the "Lateral line 
input -point mode". You can input the computer while automatically 
displaying a line in Bezier curve. The correction can return in "shift + 
mouse click" anytime.
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◎ Facial profile input change
Some people pointed out that it is difficult to trace lines as 
facial profile or hard tissue on a screen with mouse when 
inputting. Now you can click on the specified point with mouse 
to input in version 9.0.

Operation:
1. To change the line & point input, check "Facial profile import 
with point" on the "input /output setting" menu.
2. After inputting a hard tissue as Sella, point the upper profile 
line (12 range of points).
3. Point the lower profile line (9 range of points).
4. Point the lower jaw line (25 range of points).
5. Point the upper jaw line (11 range of points).
6. To input other lines or input with SAS analysis, trace the line 
with mouse in the customary way.
7. To close, use the arrow line tool. To correct, use Bezier 
curve on the correct tool.
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Location of 33 frontal landmarks
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  1. crista galli		  Cg crista Galli
  2. condylion right 	 most superior aspect right
  3. condylion left	  	 most superior aspect  left
  4. zygomatic suture right	 zygomatic Bilateral points on the medial margin of the zygomatico-frontal suture, 		
			   at the intersection of the orbits.
  5. zygomatic suture left	 zygomatic frontal suture at intersection of orbits left
  6. zygomatic arch right	 zygomatic center of the root of zygomatic arch mid-points, right
  7. zygomatic arch left	 zygomatic center of the root of zygomatic arch mid-points, left
  8. nasal cavity right	 point on the outline of the nasal cavity at the widest area in frontal perspective right
  9. nasal cavity left	 nasal cavity at the widest area left
10. jugular process right	 intersection of zygomatic buttress and outline of tuberosity right
11. jugular process left	 intersection of zygomatic buttress and outline of tuberosity left
12. antegonial notch right	 point at lateral inferior margin of the antegonial protuberances right
13. antegonial notch left	 point at lateral inferior margin of the antegonial protuberances left
14. anterior nasal spine	 tip of anterior nasal spine just below the nasal cavity and above the hard palate
15. menton		  point on  inferior border of symphysis directly inferior to mental protuberance 
			   and below center of trigonium mentali
16. right mx 6 crown	 most buccal point at molar crown
17. right mx 6 root	 tip of buccal root of molar
18. right mx 1 crown	 midpoint of incisor edge
19. right mx 1 root  	 tip of incisor root
20. left mx 1 crown	 midpoint of incisor edge
21. left mx 1 root		  tip of incisor root
22. left mx 6 crown	 most buccal point at molar crown
23. left mx 6 root   	 tip of buccal root of molar
24. left md 6 crown	 most buccal point at molar crown
25. left md 6 root   	 tip of buccal root of molar
26. left md cuspid crown	 tip of cuspid crown
27. left md 1 crown	 midpoint of incisor edge
28. left md 1 root		  tip of incisor root
29. right md 1 crown	 midpoint of incisor edge
30. right md 1 root 	 tip of incisor root
31. right md cuspid crown	 tip of cuspid crown
32. right md 6 crown	 most buccal point at molar crown
33. right md 6 root	 tip of buccal root of molar

33 landmarks of the frontal analysis
　Following is a list of the 33 landmarks required for a frontal analysis.
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1

2

3

5

6

8

10

11

12

14

15 16

17

18

19

20

21

22
23

24

25

26

27

28

29

30

31

32

33
34

35

36

37

38

39

40
41

42
43444546

47
48

49

50

51
condylion left

anterior notch leftanterior notch right

menton

jugular process left
jugular process right

condylion ringht

4

79
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Frontal lines change into the 
Bezier curve.

　You can input frontal lines with the control points 
and Bezier curve.
As well as lateral point input, you can click specified 
points and input lines with sooth Bezier curve. It is 
possible to switch conventional line input and new 
point input.

Confirm whether there is a check mark at the "Lateral 
Froantal Line Input - Point mode" in "IO Setting" 
menu. If it is unchecked, click and check the "Lateral 
Frontal Line input - Point mode." After finishing to input frontal analysis points by the 

"Tracing" tool, click the "Arrow" tool to input lines. 
You can input lines while automatically displaying 
lines in Beizer curve. The correction can be returned 
in "Shift + mouse click" anytime.
If you uncheck "Lateral Frontal Line Input - Point 
Mode," you can use conventional line input.
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14 landmarks of the Submentovertex analysis

  1.   Pogonion
  2.   Foramen spinosum right
  3.   Condylion lateralis right
  4.   Lilian point right
  5.   Right marker rod
  6.   Gonion right
  7.   Condylion medialis right
  8.   Odontoide
  9.   Left marker rod
10.   Condylion lateralis left
11.   Lilian point left
12.   Condylion medialis left
13.   Gonion left
14.   Foramen spinosum left
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3. "Patient I.D." Input
      You can display a screen by clicking the "Patient I.D." in the "View" menu all the time. 

　Name 	 : Input a patient's name.
　Case No. 	 : Input a Patient's  case number.
　Gender 	 : Click the arrow button and choose a patient's gender.
　Birthday 	 : Input a patient's birthday. (month, day, year)
　　　　　　	  (For example: You can input the year of birth 1991 as 91.)
　X-Ray 	 : Input the date when the X-ray was taken.
　　　　	  (For example: You can input  the year of shoot 2001 as 01.)
　Race 	:  Click the arrow button, or input the first letter of the race, and choose.(For 			 
 example: You can input the Caucasian as "C" or "c".) 
              	  Japanese:J or j / Oriental:O or o / Hispanic:H or h / Latin:L or l / Black:B or b
　Status 	 : Input a X-ray condition.
　　　　	  （For example:  initial, growth, treatment(VTO), progress, final, T1, T2 or any 		
	  other words）
　Rate 	: Generally choose "1".

・Enter a patients information, using the tab key to go from box to box.　
・Click the [OK] or press the return key, when you finish to input.

※　Be sure to input [Gender] and [Race]. If not, analytical values don’t appear.

You can choose a file name by checking  
the box.

When you check a top box, the file name 
will be "sample_initial.a2z".

When you check a bottom box,the file 
name will be "12345A_initial.a2z".

User defines "Status" of "patient ID input".

Click a "definition" button. 
Input the item name into a box. It is registered when you 
click "OK". 
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5. Save data
・Save data once. A dialog box appears when you click the Save tool.

A computer asks where to save a file.
・Choose a folder, and save a file.

　Bit of advice

We will explain how to manage patients’ files here. Create a "patient folder" on the desktop first, and 
create "A" "B" "C" ....folders in it.
(When you manage them with numbers, create folders such as "100" "200" "300" ......)
For example, in case of a patient "Billy Clinton", create the "Billy Clinton" folder in the "B" folder, and 
save the initial file in it.
In this way, when you crate the other files as treatment or final for Billy Clinton, save all of them togeth-
er in the "Billy Clinton" folder. It helps to manage with ease.
And, when you backup these files, save the whole "patient folder" regularly in another Hard disk, or 
CD-R /RW, and so on.

4. Change an Analysis
You can change any Analysis instantly, when you click the analysis name in the Analysis menu with a 
mouse. Multi stage and Linear support only for Asian people. (You can not use it for Caucasian.)

Ricketts analysis McNamara  analysis
You can define your original 
analysis among these 4 
items.

28
CephaloMetrics AtoZ

TM
  



6. Add a color photo

You can add a patient's color photos with a digital camera or a slide.
For a digital camera, input a color photo to a hard disk drive with a card reader or others. For a slide, 
with a scanner with the transparent unit, a film scanner or others.
(Color photos are supposed to be taken with JPEG file here.)

Add a color photo to the sample file. 

・If you close it, click the Open tool , and open it.

・Next, click the Add tool .

Attention!  Note that if you input an image with the New tool  , it becomes another file.

Color photos are saved  in the "color 
photo" folder in desktop as left.

　Bit of advice

Following is the standard image size to import into the AtoZ. Note that if you import too big size im-
age into the AtoZ, it may cause a computer run slowly or freeze.
To change an image size, Photo retouching software such as the Adobe Photoshop is needed. 

　　　＜　The standard image size　＞
　　　・Pixel size : 640 × 480 pixel

　　　・The data size of 1 frame : 300 〜 500 KB

　　　・Record form : JPEG (Save at the highest quality.)
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Inport within the 
frame.

frame (512 × 468 pixel)

  color photo
 (640 × 480 pixel)

・When the dialog box appears, choose [1Lateral.
JPG] in the folder, and click the "Open".

The dialog box as left appears.
You can adjust an image, such as "Re-
place right and left", "Replace upside 
down", "Rotate -90dg Clockwise", and 
others with this dialog box.
Also you can adjust the frame size by 
dragging the bottom right part of the 
frame. (marked with a red circle)
When you drag the center of a frame, 
you can move the frame itself.
・After you set a frame, click the [OK] 
button.

 Bit of advice

If you set up the color photo size as 640 × 480 pixel by using Photoshop and others in advance, you 
can save your time to adjust the frame.
(The standard display resolution is 72 dpi, so the import frame size will be 512 × 468 pixel.)

・When you click the Add tool, the dialog box to input an image appears.

First, add a JPEG file [1Lateral.JPG] in the "color photo" folder in the desktop within the frame marked 
with a red circle.
・Choose the "Image File" in the "Color Input Source", and click the button of the lateral color photo 
marked with a red circle.
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◎ New angle adjustment

A cross line rotates, when you drag up or down a right edge in a cross line to take an oral image. You should 
put the inclined image and the cross line in a horizontal position.
And drag it and release the mouse button, the rotated image appears. You can do it as many times as you 
like.

　　

When the image is in a horizontal position, click the OK button and import.

A computer asks "Input to New Window?". 
・Click the "Add" because the image is added to the file that is currently  open. 

◎ Import an additional image with the Thumbnail tool

You can import additional JPEG files with the thumbnail tool.
・Open the desired file to add images in advance.
・Click the Thumbnail tool.

Please refer to 「◎ Import an image with the Thumbnail tool」for information about image in-
put.
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7. Trace positioning

figure. 7-1

When you use as mentioned in this textbook, a color 
photo is supposed to be imported as the figure 7-1.
As you see, when a color photo is imported at  first, 
there is a displacement between the color photo and 
the trace position.

To correct it, use the Position tool .

・Click the Position tool on the upper right corner of the 
screen.

figure. 7-2

figure. 7-3

Then, the trace changes into the profile line where a 
box stuck to the Glabella and the Embrasure as the fig-
ure 7-2.

・Drag the box A to the Embrasure position of the color 
photo first.
・Then, drag the box B to the Glabella of the color im-
age, and put them together.

You can adjust the profile line scale size and inclination 
by moving the box B.
 

・After finis positioning the A and B box, click the Arrow 

tool .

The color image come to correspond with the trace as 
the figure 7-3.

A

B
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The Bezier curve is a curve expressed with the anchor 
point and the handle as the left figure shown.

In a word, a curve A'C means a vector a which shows 
length and direction from a point C to A. A curve B'C 
means a vector b which shows length and direction from 
a point C to B as well.

8. Correct a Trace 

You can correct inputted measurement points and 

lines by clicking the Correction tool .
When you click the Correction tool, all lines 
change into the Bezier curve as the figure 8-1. 
We will correct the line of the soft tissue here.

Before that,  we will explain about the Bezier 
curve.

What is the Bezier curve?
You can correct a soft tissue line, an upper and a lower jaw hard tissue line, (A hard tissue copes with 
it after Ver. 4.) with the Bezier curve in CephaloMetrics AtoZ.
This column provides descriptions about the Bezier curve.

Therefore, for example, when you drag a white circle A   

to the upper left with a mouse, you can change a smoothly 
level of a curve (the size of R) as the figure below.

figure. 8-1
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Now we will drag a red circle C    to the lower.

Then, You can see that the curve moves together with the circle.

C

How to correct a line with the Bezier curve

Could you understand what the Bezier curve is ? We will actually correct a line of a soft tissue and a 
hard tissue with CephaloMetrics A to Z here.

8-1. Correct a soft tissue

・Drag a red circle  on a Bezier curve to a soft tissue line first.

You can point a red circle easily on a straight line, because there is relatively wide interval among adja-
cent circles. On the other hand, there is only narrow interval on a curve line, so  take care to point. 
When you move a red circle, be careful to leave appropriate interval.
・After finish correcting red circles, drag the green arrow to correct a line curve to correspond with a 
soft tissue.
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 Bit of advice

When you correct points or lines, you should use 
the Loupe tool (expansion) to expand a image. It 
helps that you move an image with a Hand Tool, 
you can display a place to correct  in the center.

Different from a soft tissue correcting, when you correct a 
hard tissue, you should correct overlapping points. （Total 

15 points, as ANS, PNS, Point A,  Point B, Menton and 
others on the upper and lower. ） When you move a cursor 

onto a point to correct, an arrow cursor  changes into 
the circle ○ . So you can't move a red circle.  Therefore, 

you should move a cursor while holding a Shift key to 

move a red circles .  

When a red circle  overlapped with the green arrow, you can’ t point the green arrow as you like . To work 

it out, you should move a cursor   while holding a Control key in Windows (Mac: holding an option key).

8-2. Correct a hard tissue line

After finish correcting a soft tissue, correct a hard tissue line next. 

・To change an image from a color photo to a X-ray image, click the lateral X-ray icon  in the Tool 

window.
・Click the Correction tool in the Trace tool window.
The X-ray image appears as the figure 8-2.

figure. 8-2

35
YASUNAGA Computer Systems Co.,Inc.



The wrong Sella position

The arrow cursor 
changes into the 
circle.

The right Sella position
（click this position.）

・To correct a measurement point, click the 

Correction tool .

A cursor changes into the circle when you draw 
a cursor close to the measurement point  to cor-
rect. And that point, click the mouse once.

・Click the left button.

8-3. Correct a measurement point

Then, the name of that measurement point ap-
pears clearly on the screen with the computer's 
voice.

・Confirm it, and click the right position with a 
mouse.

As you see,  the position(Sella) has been  cor-
rected. 
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・ Trace it with X-rays image. 
・Change it in a color photo. 

・Revise a soft tissue with a  "Correction" tool and save it.

・Soft tissue is made separately.

8-4. X-rays and Photo input the trace of the soft tissue separately.

◎ You can revise the position of the tooth of the trace. 
Drag the inside of the shape of the tooth and can move the whole tooth.
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9. A morphing of a lateral color image

The image morphing function in AtoZ, which can simulate a post treat-
ment prediction, is effective to motive the patient. We will go into detail 
about how to use.
・Open the patient data to do a morphing. 
・Click the "Treatment" in the View menu.
Then, "Treatment Dialog" and "Treatment Window" open as the figure 
below.
You can input numerical value to the dialog box directly or move a box 
on a trace.
They work in conjunction with each other, so you can choose more 
convenient way to run a simulation.

When you point the arrow cursor inside of a box and drag it, the cursor will change to a plier for the 
orthodontic treatments, or to a scalpel for the surgical treatments.
・To translate a tooth image, put the arrow cursor on it and drag.
・To change a dental angle (inclination), drag the box on a root apex or a head.
・To rotate a whole maxilla, drag "the box of PNS" while holding the control key.
・To move a whole maxilla, drag "the box leaning to PNS" while holding the control key.

Some tools were moved here from the Tool window. 

Change treatment in FH and Occlusal plane. 
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We will move an image actually to explain the image morphing function here.
・Translate upper and lower incisors to the front.

・Click the Morphing tool next. 
As you see, an image has changed as the left fig-
ure.

When you move the trace box on a color photo, the numerical values in the "Treatment Dialog" will be 
changed in conjunction with it.
※ On the contrary, to move the trace box on a color photo, when you change the numerical value in the 
"Treatment Dialog" and click the Morphing tool. 

・Click the Trace change tool here.
You can display the line to compare the amount of change of a soft tissue.
 
A blue line : "a current soft tissue line"
 
A red line : "a soft tissue line after a treatment"

・Click the Trace change tool.
The Trace change tool is a toggle button.
You can change the blue line display on or off by clicking the Trace change 
tool.
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◎ How to use the frontal treatment

Orthodontic,orthognathic and surgical treatments can be simulated only by dragging the trace.

1. Open the frontal file which the points and lines was input, 
and choose the "Treatment" of the View menu.

Then, click the frontal icon of the Tool window.  

2. Drag the tiny boxes directly to simulate it.
A frontal doesn't have a treatment function by input of numerical value in the "Treatment Dialog".
You must input 4 lines to simulate like the figure.
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◎ Morphing movie

We achieved to display not only the images after a simulation, but also perioperative changes of  patients as 
movie. You can see both frontal and rateral on either Windows or Macintosh software.
Operation
Open the patient's file first, and select "Treatment" from the menu. Input the value in a dialog box or drag 
the box on a trace.

The peritreatment trace appears when you click the trace change button , and it changes into the facial 

configuration after a simulation when you click the molfing button.   To create a morphing movie, click 

the animation create button.

For Mac, click the play button on the bottom-left 
to play, and select save or not when you close the 
window.

Select the size and trace(with or without), and click the 
create button. And a movie is created and the movie window 
appears.

Macintosh Windows
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A simulation position in a Treatment 

anterior maxillary osteotomy

rotate anterior maxilla
around the tip of the incisor

tip occlusal 
plane

rotate posterior maxilla,
(+control key) rotate a whole 
maxilla around the incisor

translate posterior maxilla,
(+control key)  translate 
a whole maxilla

tip upper molar

tip lower molar translate anterior 
mandible

rotate anterior 
mandible

torque upper 
incisor

torque lower 
incisor

Genioplasty

move point A

mandibular body osteotomy

sagittal splitting ramus osteotomy

vertical ramus osteotomy

translate anterior 
maxilla

 maxillary corticotomyLe Fort １type 

dento-alveolar osteotomy

rotate mandible around 
the  Condyle Axis
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tip maxillary

maxilla movement

Genioplasty
translate mandibular mentum

translate lower jaw
tip lower jawtip lower jaw

tip mandibular mentum
tip mandibular mentum

A simulation position in a Treatment (frontal)
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10. How to display an image of before-and-after treatment comparison

When you open two windows, two comparative 
images appear. And when you open three win-
dows, three comparative images appear.

When you click the "Select View" button, the forms to choose appear. 
You can choose a form from the list.

This chapter provides a description about the method to display before-and-after treatment predicted 
Morphing images at the same time.

・Click the View Layout tool  .
"View Palette" appears.

There are 28 kinds of image display formats in AtoZ.
The 23rd format is a "comparative image display mode". 
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・Click the "Growth" in the View menu.
・Input years to the Growth dialog box.
   We input [2.0] (years) here as an example, and click the [OK].

You can display a superimpose only when two or 
three windows are opened.

We will open an initial file, carry out "growth" and 
"treatment from the growth", and then superim-
pose those three data.

・Open an initial file first.

The "Growth 2.0" window opens.
Note that the red circle display as the left figure.

・Click the View menu here.

◆ Window 1 [1]    
◆ Window 2 [2]  

 
Therefore, you can see...

Iinitial file = Window 1
Growth file = Window 2

When you see the View menu, only 
the letters of "Window 1" are black. 
You can see that the initial file is  
the "Window 1" from this.

11. Superimpose
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・Click the View menu here again.

◆ window 1 [1]
◆ window 2 [2]
◆ window 3 [3]

Therefore, you can see...
 
Initial file = Window 1
Growth file = Window 2
Treatment file = Window 3

・Next, click the "Treatment" in the Display menu with a Growth file indicated.
Then, the "treatment" window in the treatment file opens.
Note that a red circle display as the left figure.

※ Note that this treatment file also reflect the contents of a Growth.
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・To see a variation  in the data, 
translate the incisor of both upper 
and lower to the front in the treat-
ment file window.

 Superimpose1,　

Superimpose2,

 Polygon 

Each superimpose is available as 
you click button of Superimpose1 
too l , supe r impose2 too l , and 
Polygon tool with three windows 
of initial, Growth and Treatment 
opened.

　 Polygon

　5Superimpose of Ricketts

　Superimpose1

　Superimpose2
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◎ Superimposition of X-ray images

 You can display the superimposition of X-ray images .
・Open the two X-ray images to superimpose.
・Choose the "Superimpositions X-Ray" in the View menu.

You can adjust an image density with 
the scroll bar. You can rotate and 
translate an image freely, and compare 
the images front and behind.
Also the doctors who use digital X-ray 
machines can superimpose images on 
the screen.
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◎ A position of a Facial Diagram superimposition and a reference plane 
customization

Sella Nasion

Orbitale

ANS
A point

0
5

6

12
7

mx1-Incisor superius19
md1-Incisor inferius 21

B point10

Pogonion9

Menton 18

15

29Gonion

Articulare

You can customize a position of a Facial dia-
gram superimpose and a reference plane.
・Click the Facial Diagram tool.

The Select dialog box appears.
・To customize, click the radio button in the 
"Custom", and then the "BASE" button.

The Superimpose3 dialog box appears.
・Define a reference plane and "Lateral" reference point.
 
  reference point:   6  (Orbitale)
  reference plane:    0   (Sella)      5   (Nasion)

・Input it, and click the "OK" button.

    Yoshiko Kawamoto .initial
    Yoshiko Kawamoto .Growth 2.0
    Yoshiko Kawamoto .Treatment

The superimpose of three data and the standard value 
appear as the figure.

 
<Note>
※ The values inputted to a reference point and  
plane are the same as the value ina user analysis 
definition.
※ You can display the standard values only if you 
use of the 12 points for the reference points and the 
reference planes as the left figure.
 
(If not, the standard values don’t appear.)

The 12 points which compose a Facial Diagram
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Therefore, when you superimpose the N point on the FH 
plane...

 
  reference point:   5  (Nasion)
 
  reference plane:    1   (Porion)      6   (Orbitale)

・Input the values, and click the "OK" button.

 
   Yoshiko Kawamoto .initial
 
   Yoshiko Kawamoto .Growth 2.0
 
   Yoshiko Kawamoto .Treatment

Then, the superimposition of three data appear as the 
figure. But the standard values don’t appear.

You can display up to 3 standard values 
at the same time.
 

Median of the occlusal molar

PNS

※ These are patient's data, not the stan-
dard values.
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12. Print

The parenthetic number in the View menu shows the page 
number to print.
In a word, when you want to  print only "the window 1", 
specify a page number with "1".

・When you want to print parenthetic, input "5" to the page 
box. 

Window 2
The result of the "growth" prediction, "VTO" and "MVTO" in 
the View Menu appear.
Window 3
A treatment simulation of the  "Treatment" in the View Menu 
appears.

・To print out, click the Print tool .

・A printer driver starts. For example, when you want to print the polygon, click 
the radio button in "the designated page", and input "9" in the blank.
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◎ Ricketts analysis items
When you select A4 or US letter-size to print out the existing 
Ricketts analysis over two analysis items, the analysis items 
appear over 2 pages. Now you can print out the items into 1 
page. And also, you can print out measured values eliminating 
overlap with the image to improve visualization.

Furthermore, you can print out a Daiagnosis with anything but 
Downs & Kim analysis, when you check "Daiagnosis print" on 
the display setting menu. 　

◎ Setting of a print direction

Now you can switch between A4 vertical and horizontal print for the trace of the patient window and X-ray 
image. Due to a large number of positions in output samples from abroad, we added a wide print option. 
Operation
・You click "Line Width, Color, Patterns..." on the Disp. Setting setting menu.
・Check the "v-position" botton
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13. Copy and paste

(2) Click the polygon once to activate. And Click 
the "copy" in the Edit menu.

(1) Open a patient data file with AtoZ, and 
display a polygon.

(3) Start Excel, and click the "paste" in the Edit menu.
You could paste a polygon on Excel with this.
You can paste it on PowerPoint, Word, Illustrator, and so on in the same way.

You can copy and paste any data which were made with AtoZ.(In such cases as the X-ray image, the 
color photo, the measurement value, the facial, the polygon, the treatment, VTO, the superimpose 
and the gallery) on other software. 
This chapter provides a description to paste a polygon to Word document, for example.
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 Bit of advice

This column provides descriptions about the condition that a window is active.
"Active" means "available".
When you click the "copy" with many windows opened, a computer copies only the active window con-
tents. 
As the figure below, a color image window is active in the left figure, and a X-ray image is active in the 
right.
To make the window active, just click the desired window with a mouse.

54
CephaloMetrics AtoZ

TM
  



56  md7 distal

55  md7 mesial

29  md7 distal

30  md7 mesial

31  md6 distal

32  md6 mesial

・Next, input the lower model point.: Click the Tracing tool again. , and Input 28 points as the figure 
below.

・Click the Arrow tool  to terminate a point input session.
If you don't input patient's data yet, the "Patient I.D." dialog box appears.
・Enter the "Patient I.D.".

・When you finish filling out the "Patient I.D.", 
Click the "OK" button.
Input data and an ideal arch appears.
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B （the frame of the lower）
A （the frame of the upper）

14. About a Model analysis

・Click the New tool  in AtoZ or the Add tool .
Input dialog box appears.

the upper

・Open the cover of a scanner. 
・Set the upper and the lower model horizontally to the scanner.
・Cover the model with a cloth instead of the cover, because the upper cover isn't closed. (The white 
cloth is best.)
※ The active scanner is EPSON ES-2200.
※ Don't cover a part of a glass on the top of a scanner with cloth. (It causes faulty operation.)
※ You choose "a manuscript base" in "the manuscript kind" items of the scanner driver because a 
transparent UNIT isn't used when you import a model. (Subsequent page reference.)

・Click the button of  A  (the frame of the upper model) if you are ready to import.

・Turn on the "Scanner" radio button in the "X-Ray Input Source".
・Click the "Select Twain" to choose Twain of an active scanner.

the lower
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　Setup example;  EPSON ES-2200

Manuscript type : manuscript base
Image type : 24bit color (standard)
Output unit : screen / WEB
Resolution : 144 dpi
Manuscript size : 1024 × 936 Pixel
Output size : 1024 × 936 Pixel (90 × 83mm)
Zoom : 100 ％
Trimming： On

The Scanner Twain driver starts. (EPSON ES-2200)

・ Choose the "manuscript base" in 
the "manuscript type", and Click the 
"preview" button.

If you have a setting save data, push 
a "setting preservation" button, and 
Read it.
If not, save a data, referring to the 
setting data as the left.

・Drag the center of the import frame 
displayed on the preview screen with 
a mouse. 
・Set the frame to adjust the upper 
model to be located inside.
・If you finish the setting, Click the 
"scan" button.

・Click the button: B  (the frame of 
the lower model), and import the 
lower next.

The import frame size of  both the 
upper and the lower are same. So, 
you can read the setting of the up-
per, and just move the import frame 
to the lower model.

・If you finish the setting, click the 
"scan" button.

The upper and the lower model im-
ages were imported into AtoZ with 
this.
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・Click the Tracing tool , and input 28 points from  1  mx7 right upper: distal  to  28  mx7 
left upper: distal.

　※　You can't analyze A child's model.
　※　When there is a missing teeth, input a hypothetical point.

7  mx4 distal

6  mx5 mesial

5  mx5 distal

4  mx6 mesial

3  mx6 distal

2  mx7 mesial

1  mx7 distal

27  mx7 mesial

28  mx7 distal

the model imported into AtoZ

This is the imported model.

You input points from now.

・Before that, Expand a screen with a Loupe tool  

(expansion)  , and display the upper model with 

a Hand tool.

・If you finish the upper point input, drag an image with a Hand tool , and display a lower 
model.

58
CephaloMetrics AtoZ

TM
  



An entered tooth line・・・・・ blue line
An ideal arch・・・・・・ red line

There are total five anchor points on the ideal 

arch（ ）, including the canine tooth × 2, the 

second big molar × 2 and the center point of the 
front tooth. You can change the arch position by 

dragging them with the Arrow tool. 

If you drag a handle（ ）, the size of the arch 

will be changed.

・Click the "Correct Tooth Size..." in the Analysis 
menu.
A dialog box as the left figure appears.

You can input slide gauge data here.

 When you click the Polygon tool, the 
polygon of the model data appears.

And, you can display the polygon of the Model Analysis and the input dialog box of the slide gauge data  
when you manipulate as the following with a Model Analysis indicated.
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A dialog box appears when you click the "Define Standard Tooth Size..." 
in the Define menu.
You can establish the Norm and SD values with this dialog box for each 
race and sex.

※ To active the change, you should input the numerical value and click 
the "Change" button after you input.
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◎ Model modification and Additional function
When you input a model with mesial and distal data, you can see the width among a blue, red, & green 
point. To undo it, hold down the Shift key while click a mouse button.
For the model image import: To calibrate, import the image with a scale that was taken by digital camera.
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◎ For Little Irregularity Index of a model
Upper Little Irregularity Index and Lower Little Irregularity Index have been added to a model image with 
polygon.
For Little Irregularity Index: It figures out the sum of the mesial & distal between the sum total of Kon 
centrifugal between canines.

Also other dental arch width & length 
display have been added to the upper 
& lower with a model polygon image. 
After measuring with a slide gauge, input 
those values into the Tooth size ... on the 
analysis menu.

The model Image with polygon has been changed as follows.
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◎ How to make the informed consent document by the Thumbnail tool

How to make the informed consent document which used CephaloMetrics AtoZ is explained.

1. Take pictures in the oral cavity of the patient with a digital camera, and take image data in the com-
puter with card reader and so on.
※ Photography parts are six places of "maxillary surface" "mandible" "the left oblique side" "the front" 
"the right oblique side" and "the overjet" in the oral cavity.
You make the fo lder which gave the name which was su i tab le for the desk-top com-
pu te r. You copy a l l t he image da ta o f the d ig i t a l camera i n to tha t fo lde r en t i r e l y. 
(It is all right even if the image which failed in the photography mixes.)
※ The picture quality setting of the digital camera is to refer to the following. A computer may freeze 
when the data size of an image to paste is too big. Be careful.
      Number of record pixels : 640 × 480 pixel, 

      The picture quality mode : low 〜 middle resolution (BASIC, NORMAL)
      The data size of 1 frame : 300-500KB,  File format : JPEG

When you want to preserve an image with high quality, it is suggested that you use the batch function 
of "Adobe Photoshop Ver.5.0 and more". You can make the image data downsized for AtoZ, and you 
can paste it.

2. Start AtoZ, and click the Thumbnail tool. 
A JPEG thumbnail input dialog box appears.
3. Click the "Folder" button, and specify the folder which copied an image.
Then, all the image data inside the folder are shown by a thumbnail list.
Drag and drop an image to the respectively fixed position in the oral cavity, and 
take it in AtoZ.
And, arrange "the overjet" to the position on the upper left of the bottom step of 
ETC.

4. Press the "OK" button.
You can confirm that an image inside 
the oral cavity was taken in as a file 
of AtoZ.
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5. Click the "Patient I.D." of the View menu.
    
If a dialog box appears, input data in each of the blanks.

・Input a patient's data.
・Input either "m" (male) or "f" 
(female) to "Sex".
・Input "j" to "Race" in case of a 
Japanese.
・ Whatever you input to "Status", 
it is all right. You input the word 
which shows the condition of the 
file.
Example :  initial, 1st, A ...etc.

・If your input is finished, press the 
"OK" button or the return key.

6. Click the "Inform [11]" of the View menu.
Images in the oral cavity taken in is arranged automatically, and the dialog box of the informed consent 
is displayed.
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"Upper Right", "Upper Left", 
"Lower Right", "Lower Left" "Center" "Relations (RM)" , "Relations (LM)"

7. Click the "INFO" button to input information of your clinic.
You can input respectively favorite information to each item of 
"A hospital name", "On a consultation day" and "Information 
1 and 2". You can input it until 88 characters in "Information 
1and 2". (So, more than 89 characters is not printed.)
And, these items are memorized all the time unless you 
change contents once it is input.

8. Click the "DATE" button.
The item of "BirthDay" is input automatically because it links 
with the "Patient I.D.".
Input the day when you took pictures in the oral cavity to 
"Date". (Or, you can input the day when you print a docu-
ment, and have an interview with the patient.)

9. A dialog box appears respectively when you press the button of "Upper Right", "Upper Left", "Lower 
Right", "Lower Left", "Center", "Relations (RM)" and "Relations (LM)".
You can choose one each respectively. You can input comment until 28 characters into blank column.

10. Press the "Comm1" button.
 
You can display even which to 5 items.
(When you choose more than 5 items, AtoZ de-
letes the one after automatically. You can input 
comment until 65 characters into blank column.)

11. Press the "Comm 2" button.

You can display even which to 4 items.
(When you choose more than 4 items, AtoZ de-
letes the one after automatically. And, you can 
input comment until 100 characters into blank 
column.)
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　　　　Phone +81-776-33-5333,  FAX +81-776-33-5334
　　Address：2-20-3,Hanando-Minami,Fukui 918-8015 JAPAN  http://www.osas2003.com

　　　　　　　　　　　　　　○×△◇ Dental Clinic
　　　　　　　　　On a consultation day：Mon, Tue, Wed, Fri, Sat
　　　　　　　On a consultation time：10:00 〜 12:00, 14:00 〜 18:30（Sat 17:00）

Cindy Tanaka　 　10y 10m　　　　5.4.2010

12. When you print an informed consent document, you set up a page in 
"11".

13. An output example is shown in the following.

Days from the birthday when it is input with 「DATE」 until the consultation 
day are calculated, and it is indicated as an age. And, these items links 
with the items of "BirthDay" of "Patient I.D.".

"Comment 1" can be displayed to 
5 items.

"Comment 2" can be displayed to  
4 items.

"The jet image" taken in the po-
sition of ETC is indicated in this 
position.

"information 1" of "INFO" button
"information 2" of "INFO" button

"a hospital name"

"On a consultation day" 1

"On a consultation day" 2
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2. Choose "Bimler" of the Analysis menu.

3. Click the Tracing tool of the Trace tool window.

4. Input 36 points for the Bimler analysis.
You must input 4 new points which aren't used to other analyses for the Bimler analysis. That is the 
point of the following demanded after the 32nd point "PAC" input.
You input these points in order, too.
 
※ Pay attention because the voice of the computer doesn't come out.

◎ How to use a Bimler analysis

1. Start AtoZ, and open a lateral X-ray image.

5. Input 4 lines in succession after 36 points input.

The additional 4 points of the 
Bimler analysis

  　 33　 AP

　　34　 Mentale　　　

　　35　 Point 1　　　

　　36　 Point 2　
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6. When you click the Arrow tool after 
imput, you can indicate a Bimler analysis 
(indication for the right).
And, click the "Reverse BIMLER Trace" 
of the Disp. Setting menu when you 
change it to the indication for the left.

Bimler analysis (indication for the right)

The undefined points 
are collected around this 
red circle.

Attention
4 points of only Bimler are not in the right position even if you open the file which only 32 
points and 4 lines are input to and you choose "Bimler" of the Analysis menu.
But, you can correct 4 new points to the right position with the Correction tool.

・Click the Correction tool  to correct 4 new points.

4 new points are collected into the position where it was marked the red circle of the 
figure.
・Correct 4 points referring to this textbook "9-3. Correcting the measurement point" in the 
right position.

※ Because you can input only 32 points by the Template input, correct 4 new points identi-
cally.
※ The undefined points added newly are collected into the position of the red circle with an 
original analysis of "User4",too.

68
CephaloMetrics AtoZ

TM
  



Bimler analysis (indication for the left)

7. Only trace changes into the indication for the left.

Next, click the Flip tool.
The X-ray image turns over for the left, too. 
But, it isn't correspond to the trace.

8. Click the Position Tool  with pressing 
Win: control key
Mac: option key 
to fit a trace with the X-ray image.
Then, it becomes the trace correction mode like a figure.

9. Move the white boxes.

(1)  Drag the right box to the position of Porion first.

(2) Put it together with turning the left box to the position 
of Orbitale.

10. You could position it like this.

PorionOrbitale
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◎ SAS Analysis (Abput additional 
point).

If you wish to use SAS analysis, you have to add 14 
points and three lines. 
 Before you input point, you select " SAS Analysis " 

Anterior arch of the atlas vertebra

in Analysis menu. 
 you input 32 point, and you input 14 point for SAS.
  Next, you input regular 4 lines, after you have to 
input three SAS lines. you can see below.
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　　　Examples of Printing SAS analysis
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◎ Multi Stage Analysis (Japanese norm)

The analyses registered at present are Downs-N.Western (Miura and Iizuka) and Downs-N.Western 
(Nakamura) and Downs-N.Western (Type3).
You can't make a Multi Stage Analysis freely like an original analysis. Make contact to our company 
when you want to register the analysis of other universities.

・Open the X-ray image that point input was finished in advance.

1. Click on "Select Multi Stage..." of the Define menu.

3. Click the "Multi Stage" of the Analysis menu.

2. Choose the standard value of an analysis to use.
Click on "Downs-N.Western (Miura and Iizuka)" here for example,  click 
the "OK" button.

4.   The "Select" dialog box appears.
Standard value is chosen automatically by the age of the patient computed from "BirthDay", "X-Ray" 
and "Sex"that it is input in the "Patient I.D.".
A "IIIC : 11y2m ± 1.1" is chosen. And, it is possible that you choose other standard value, too. 
・Press the "OK" button after the confirmation.
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5. Click the Polygon tool. The polygon window appears.

6. The polygon window like a figure is indicated when you choose a "IVA : 11y7m ± 2.5" at the "Se-
lect" dialog box on trial.
You know that standard value changes automatically by the sex and the age from this.

At this time, the polygon window like a figure ap-
pears when a check is added to the "S Polygon" 
of the Disp. Setting menu. You can choose favor-
ite indication by clicking on the "SD Polygon".
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Point  1

Point  2

３． Click the Measure tool of the Trace tool window.
After the following dialog box appears, click the [OK] button.

２. The choice of the 2 Points Calibration

・Confirm that a tick mark doesn't have it about the "4 Points Calibra-
tion" of the IO Setting menu.

※ You can give a mark by clicking the "4 Points Calibration", and it 
can be removed.

※ You can use a 4 points calibration when a tick mark has it about 
the "4 Points Calibration".

４. Input two optional points in image.

・After [Point 1] is displayed, click on one optional point in 
screen.
・After [Point 2] is displayed in succession, click another op-
tional point.
・Input [Point 1] and [Point 2] as the figure for example.

※ Even if two optional points aren't parallel to a X axis or Y 
axis, it is all right in case of 2 Points Calibration, if the distance 
is accurate.
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About the image calibration

You must surely calibrate it when you take the JPEG file of the X-ray in AtoZ (when you take in an X-ray 
image from the digital X-ray machine).
The value of the distance analysis isn't correct even if you analyze it as it is because a JPEG file 
doesn't have information on the size from the first.
Therefore, the image calibration operation which gives a JPEG file information on the size is necessary.

※ The standard of the size must be taken by the inside of the X-ray image to calibrate.
When you take X-ray, you must take pictures of the scale which becomes the standard of the size 
together to calibrate.

The method of the 2 Points Calibration
 
1. Take the JPEG file of the X-ray in AtoZ.

・Turn on the radio button of 
"Image File" in the "X-ray Input 
Source".
・Click the X-ray image button of 
"Lateral".

・Adjust a frame in the JPEG intake 
dialog box, and press the [OK] 
button.

The X-ray image is taken in AtoZ 
as the figure.
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"Rate" is "1" in case of the X-ray ma-
chine to use in the general clinic.
You can cancel the calibration if you 
click "1".

５. Input a distance between two points.

・Input a distance between two points.
・Click the [OK] button.

The operation of the 2 points calibration is completion in 
the above.

Attention

※ 1. You can calibrate respectively and independently for "Lateral","Frontal" and "Subm.".

※ 2. When you want to cancel the calibration.
・Click the "Patient I.D." from the View menu.
・Click the radio button except for "Calibration" with the "Rate" of the dialog box.
(But, be careful because all calibrations ("Lateral","Frontal" and "Subm.") are canceled at a time.)
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The method of the 4 Points Calibration

１. Confirm that a tick mark has it about the item of the "4 Points 
Calibration" of the IO Setting menu.

※ You can give a mark by clicking the "4 Points Calibration", and it can be 
removed.
※ You can use a 2 points calibration when a tick mark doesn't have it 
about the item of the "4 Points Calibration".
※ You can use a 4 points calibration when a tick mark has it about the item 
of the "4 Points Calibration".

３. Input two parallel optional points to the X axis, and input that distance.

※ Be sure to input it in parallel in the X axis. If it isn't 
parallel, the value of the distance measurement isn't 
correct.

After you input two parallel points, the dialog box to 
input a distance is displayed.
・Input that distance, and click the [OK] button.

２. Click the Measure tool button of the Trace tool window.

４. Input two parallel optional points to the Y axis, and input that distance.

※ Be sure to input it in parallel in the Y axis.If not, the 
value of the distance measurement isn't correct.
After you input two points, the dialog box to input a 
distance appears.
・Input that distance, and click the [OK] button.
The 4 points calibration is finished.
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Tool window

New

Open

Add

Save

Print

Measurement

Superimpose1

Facial Diagram

Polygon

Superimpose2

5 Superimpose

Trace Line 
on/off

Thumbnail

Hand

Shrink

　　Subment(mono)

View Layout

　　Frontal(mono)

Panorama(mono)

　　Model(mono)

Enlarge

Frontal(color)

Lateral(color)

Smile(color)

Oral(color)

Diagonal(color)Diagnosis Window on/
off

Loope Window on/
off

TraceToolWindow on/
off

EnhanceToolWindow on/
off

PaintToolWindow on/
off

　　Lateral(mono)

ETC.

JPEG ViewerA2Z Image 
Database

Type1

Patient ID Arrow

Next analysis

Photo ImagesX-RAY Images

Previous analysis
Growth

Treatment

VTO

MVTO

Co-Cr Conversion

Soft Tissue Setting

Window1

Window2

Window3

Inform.

Diagnostic Table

Superimpose X-Ray

Save JPEGS

Open STL Data
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Type2

New

Open Add

Save Print

Thumbnail

Diagnosis Window on/
off

TraceToolWindow on/
off

EnhanceToolWindow on/
off

PaintToolWindow on/
off

Measurement

Superimpose1

Facial Diagram

Polygon

Superimpose2

5 Superimpose

Trace Line 
on/off

Hand

Shrink

　　Subment(mono)

View Layout

　　Frontal(mono)

Panorama(mono)

　　Model(mono)

Enlarge

Frontal(color)

Lateral(color)

Smile(color)

Oral(color)

Diagonal(color)

Loope Window on/
off

　　Lateral(mono)

JPEG ViewerA2Z Image 
Database

Arrow

Growth Treatment

VTO MVTO

Co-Cr Conversion Inform.
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Brightness

Reverse Video mode

Emboss

Bisector

Framing

Calibration

Positioning

Correct Point

Shade off

Tracing

Restore

Undo

Softness

Sharpness

Enhance

Custom

Reverse image

Cross Line

Parallel Line

String

Brush1

Brush3

Pen

Brush2

Lasso

Fill

Syringe

Framing

Length

Angle

Change Tool Window Type

Trace Tool Window Paint Tool Window

Enhance Tool Window
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About the Tool window
　It attached importance to the easiness to use, and the Tool window grew big, and easy to see. It is col-
lected in every related matters, and you can be handled more easily.

Arrow: To terminate a digitizing session, click the Arrow tool. Then, the input of the analysis 
points is finished. It uses for the operation as well that you move a tooth when you predict 
treatment.
New: When you input a first patient's data, click the New tool surely.
Open: To open a kept file, click this tool. This tool displays the dialog box to select a file. 
Add: When even one data are already input, click this tool to add data.The same dialog box 
appears as when you click the New tool.
Thumbnail : This tool displays the thumbnail dialog to input. You can take it in with confirm-
ing the JPEG image data taken with a digital camera by the thumbnail list.
Save: This tool displays the dialog box to save a file.
Print: This tool displays the print dialog box.You can print the document made with AtoZ.
Measurement : This tool opens a measurement window.
Polygon: This tool displays the polygon of the measurement value.
Superimpose1 : This tool displays the superimposition and a dialog box to choose a potision 
for superimpose.
Superimpose2 : This tool displays the superimposition in the upper and the lower respec-
tively.
5Superimpose : This tool displays 5 superimpose of Dr.Ricketts by one scene.
Facial Diagram : This tool displays a Facial diagram.
Trace Tool : You can open the Trace tool window indicated at the upper right of the screen, 
and you can close it. (toggle button)
Enhance Tool : You can open and close the Enhance tool window at the center of the right 
in the screen.
Paint Tool : You can open and close the Paint tool window on the bottom right of the screen.
Click the each buttons to change a view.

　　　　　　　  The lateral X-ray　　　　　　　　　The lateral color photo

　　　　　　　  The frontal X-ray　　　　　　　　　The frontal color photo

　　　　　　The panorama X-ray　　　　　　　　   The smiling photo

　　　　　　　  The model photo　　　　　　　　　　　　　　
　　　　　　　　　　　　
　　　　　The X-ray of the "Subm."

　　　　　　　　　　　　　
　　　　　  The additional image　　　　　　　　　　　　　　　　　　

View Layout : The View palette is displayed.You can choose a favorite view layout by moving 
a scroll bar inside the palette. There are 25 kinds of gallery formats.
Trace On-Off : You can choose whether a trace in X-ray and color photo are indicated or 
not.
Summary Win : This tool opens and closes a diagnosis window.
Loope Tool : When you click this button, you can expand an image, and it can cut it down.
Hand Tool : You can move an image by dragging an expanded image.
Loope Tool : You can open and close a Loope window by clicking this.
Image Browser Tool : You can open the image Browser window by clicking this.
Jpeg Browser Tool : You can open the Jpeg Browser window by clicking this.
※ Tools about the Morphing was moved into the dialog box indicated when "the treatment" 
of the View menu is carried out.

An additional image (You can indicate 
that in the view layout when you take 
in an overjet in this frame.)

Five sheets of color photos in 
the oral cavity

The p ic tu re taken f rom the 
oblique front of the face

ラテラルレントゲン

フロンタルレントゲン

パノラマレントゲン

モデル写真

サブメントレントゲン

その他のレントゲン

側貌カラー画像

正貌カラー画像

口腔内カラー5枚組

斜め45度の顔写真等

その他のカラー画像
(Type1のみ)

スマイル顔写真

(Type1のみ)
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Trace tool window
Tools about the trace are collected. 
You can input a point by using 
these tools, and you can correct it. 
There are Posit ion tool to f i t a 
trace and an image, and Mea-
sure tool to proofread a distance. 
There is an Angle Bisectors tool 
which looks for Gnathion which is 
a bisectrix at the time of the point 
input.

Enhance tool window
You can process an image in the 
part enclosed with the frame, or the 
whole of the image. You can cus-
tomize a setting, too.
You can inverse the negative/posi-
tive of the image and the direction 
of the image. When you can't do it 
well, you can take back a process, 
and you can restore the first image. 
You can fix an image until you are 
satisfied.

Paint tool window
You can copy and paste the part 
which surrounded it with "the frame" 
and "the lasso". You take in the col-
or of the place where you specified 
it with a dropper, and you can paint 
it by using that color with the pen 
and the brush in the favorite thick-
ness.
When a border is unnatural after the 
morphing, you can correct it with 
the Smog tool. You can use it prop-
erly in conformity with the correction 
point because there is smog of two 
size.

Loupe window
The Loupe window function which always 
zoomed in the neighborhood of the mouse cur-
sor was added newly.
It is very convenient at the time of the analysis 
point input and so on because you only move a 
mouse in the part which you want to see exten-
sively.
You can open and close the window by press-
ing the Loupe tool. You can close it when you 
aren't handled.

Diagnosis summary window
The diagnosis of the skeletal pattern by APDI, 
ODI, CF and Ext.Index of Dr.Kim, the tendency 
of the open bite, decision whether to extract 
a tooth, it becomes the standard which you 
choose.
The standard to judge a relapse after the treat-
ment is adopted.
It is the digital display which is easy to see. 
When you diagnose of orthodontics and oral 
surgery, a clinical experience over the past 
4,000 case of Dr.Kim is very useful.
And, the facial type of Dr.Ricketts is indicated, 
too.
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The enlargement display function of the image

The window changes to full screen when you double-click on the image. The image of the patient’s 
X-ray is displayed in the whole of the screen. When you click on somewhere on the screen, you can go 
back normal.

For example, if you want to see only an upper jaw with full screen mode, double-click on the upper jaw in 
oral case. If you want to enlarge all images in oral case, double-click on the center of the window.
In oral case, the way of being enlarged display is different whether you double-click each image or click 
on the center of the window.

When you double-click more than two images opened, you can compare enlarged images.

double-click

double-click
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Image Browser function
 
You can look out over the patient image in a particular patient folder or all patients’ folder.
The layout of the image can be set up freely. That can be defined to three patterns.
1. Click the "Image Browser" from the File menu.
    Press the “Setting” button first, and then the “Image Browser” window appears.

 2. Click the “Reference” button, and select the data of the patient.

For example: Cindy Tanaka
AtoZ Data Folder:
   Desktop-> Patient folder-> "C" -> 
   Cindy Tanaka
Layout:
	 0. Cephalo 
	 1. Frontal X-ray 
	 2. Panorama
	 3. Subment

 3. Input the number such as 0, 1, 2, 3 on “A” layout menu. And then, click “OK” button to save this set-
ting.

86
CephaloMetrics AtoZ

TM
  



 4. If you look it up with a name, turn on the radio button of "Name", and input the patient's name, and click 
the "Search" button. 
If you look it up with a patient number, turn on the radio button of "Patient ID", and input the number.
The image of data in AtoZ DATA Folder can be displayed.

※ You can always change the order of images to arrange with the “Setting” button.

< Layout : 0,13, 1, 17, 18, 19, 20, 21>

Add the date & name display to the database indication function
The date & name add to display to the database indication function.(that function has been added from 
Ver.8.a.) It is more convinient when you explainto the patient. Furthermore, you can get the expanded image 
with a full screen when you click the thumbnail two times. It helps to appeal to the patients more effective.

87
YASUNAGA Computer Systems Co.,Inc.



JPEG image database features

It is now possible to access and view image data in JPEG format. Patient's folder and image are displayed on 
the left and right side of the screen respectively. Double-click an image to zoom in.
Operation

 ・ Click the "Jpeg Browser" tool.

 ・Choose a list of images. Click the "Folder" button in the top right corner and choose  a folder you want to 
open.
 ・Folder name is displayed in the left window. JPEG images inside a folder will be listed  as you click a 
chosen folder.
 ・Double-click an image you want to zoom in, it will be shown in full screen. 

You can search a displayed folder now. Input text into a box at the upper left, and click a "search" button. 
When you return to a list, click a 'All' button.

・When "Thumb. input" is clicked, it moves to a thumbnail input. 
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JPEG output function

You can output the file that you scaned a picture into AtoZ with JPEG image data. Existing AtoZ allows you 
to copy & paste only one by one data to other applications, but now you can output some data at one time, 
and it will expand your data preparation. You can output even a trace alone without a facial configuration 
with JPEG image data.
Operation
When you select "JPEG Setting", a image output setting (JPEG) window appears.

First. set the output direction. Select the same direction on the" image output folder" as the patients data 
on AtoZ. or new direction by the radio button. Click the "Reference" button for new setting, and select the 
folder of the save direction.

Next, check the radio button of the image that you want 
to output on the "Image output setting"

Select the image compression rate, and click the OK 
button on the "Image compression".

The output setting has done with this. When you save 
the AtoZ data, the JPEG images are output to the 
specified folder at the same time.

The JPEG image is output every time you save  until 
you change the setting. If there is no need to save, you 
should uncheck every box on the "Export Preference".
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Output JPEG images without saving AtoZ data.

Without saving AtoZ data, you can export JPEG 
image files.
1. In advance, make settings what JPEG image is 
exported. Go to the "JPEG Setting" in the "File" 
menu.
2. Check images as you want to export and click the 
"OK" button.

3.  Choose "Save JPEGS" on the tool, or select "Image 

JPEG Export" in the "File" menu.

4. Choose a folder to export JPEG image, and click the "OK" 
button. And then, JPEG images are exported.

* If you turn on the "Image only" radio button and specify the folder in "Image Export Foder," when you click 
"Image JPEG Export" in "File" menu, the message as following appears. If you click the "OK" button, the 
images are saved in the folder including images in the specified location.

Select the  "JPEG image save"tool or "image Jpeg  

output" on the "File" menu, and click the OK. JPEG 
images are output.
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◎ View layout

  View layout palette varies when  selects view 
layout of setting menu by the following view 
palette is indicated, and operating a right bar.  An 
image in a palette varies by changing scroll bar in 
a palette. You select favorite view layout. 

・About 12 picture layout

Operation
Input the image used for 12 pictures layout. (Refer 
to the figure below.)

When you click the view layout tool on the tool 
window, a view palette appears. Click the "Select 
View" on the view
palette, and select the 32nd format (12 pictures 
layout) on the view format list.

・About Specified submittal case for
 Japanese Orthodontic Society (3 pcs)

Operation
Import the image that you trace by yourself on a 
scanner or with the JPEG image to the last line of 
ETC. (Refer to the figure below.)

(Jet)

Trace

Upper
overlay

Lower
overlay

Open the three f i les as the image before an 
operation, after the dynamic treatment, and after 
an operation.
When you click the view layout tool on the tool 
window, a view palette appears. Click the" Select 
View" on the view palette, and select the format for 
a specified submittal case for the test on the view 
format list.

Two formats were added in 
Ver.14. 
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◎ Loupe (magnifying glass) window 

We newly provide a Loupe window tool.
A Loupe window appears to expand the surrounding 
area of a mouse cursor, when you click a Loupe 
window tool on the tool window. To close, click the 
Loupe window tool again.

　　　Loupe (magnifying glass) window tool

For expansion & reduction of the display window
You can change the window size by dragging on 
the right corner of it with a mouse. Along with it, the 
image is expanded or reduced.

◎ Quick Ceph data import

You can open Quick Ceph Image data file directly 
with AtoZ. This feature is available only in Mac 
version.
Operation
・Send QuickCeph data to CephaloMetrics AtoZ. 
Image and lateral trace will be presented.
As for a X-ray image and lateral trace, image size 
and position do not match when Quick Ceph data 
are opened. The trace is displayed in actual size, 
but the image resolution is obscure. So, you must 
calculate the image resolution to measure the 
distance between Sella and Nasion and calibrate 
these two points. 
The QC data of soft and hard tissue lines are not 
converted and should be inputted manually.

 

◎ "ANGLE" tool　
Put three points to the X-rays image and display an 
angle.
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Display 3D models
AtoZ supported STL data in Ver.14.
It can do indication in 3D of the model.

　We support SLT data used CAD/CAM software 
on Ver. 14, and 3D models can be displayed. 
For example, STL data created by "Maestro 3D 
scanner", which is a dental model scanner, can be 
imported directly into AtoZ. 3D models imported 
into AtoZ can be displayed the measurement of the 
distance and angle and can be rendered overjet/
overbite.
　As well as image data on AtoZ, 3D model data can 
be shared and accessed on each dental chairside 
within local area network.

To import STL data from list view
Browse the folder including SLT data with list view, 
In advance, you should gather STL data into one 
folder.

1. Select a folder to browse. Click the "JPEG 
Setting" in the File menu. 
2.　Specify a folder to browse on "STL Data 
Folder". Click the "Reference" button to define the 
folder.

3. Click "OK" button and close the "JPEG Export 
Setting" window.

4.  Click the "Open SLT Data" tool or the 

"Open STL LIST" in the File menu.

5. Display the list of SLT data within specified folder.

About top 3 buttons

"Seach" button: To display only desired files.
Input folder name including STL data on left textbox. 
Click the "Search" button, and then data matched 
partially with folder name appears. Click the "All" 
button to return to list view.
"Sort" button: Change the order of sort by name or 
date modified.

5. Select data as you like, and click the "Open" 
buton. Or, double-click data file to import.

To import SLT data respectively
1. Click the "Open STL DATA" in the File menu.
2. Import STL data of an upper model and a lower 
model respectively.
Click the "Select" button to specify folders.

3. Click the "Open" button to import 3D model.

How to control 3D models

Shrink/Enlarge models: Scrolling up or down with 
mouse wheel

(  Shift + scrolling up or down in the "slice" tool 

activated.）
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Move：Drag models holding right click.
Rotete：Drag models holding left click.

Change colors
1. Click the "STL Model Material, Back Color Settings" 
in the Disp. Settings on menu.
2. Click the "OK" button after adjusting each slder bar.

Red
Green
Blue

Click the "default" button to be restored to default 
color settings. 

 Show all

Show both maxillary and mandibular.

 Show maxillary

Show only maxillary.

 Show mandibular

Show only mandibular.

 Close mode

Show close model.

 Open mode

Show open model.

 Front, Back , Right, 

Left, Top and Bottom view.

The color is set in RGB.
The upper row is Red, the middle 
is    Green, the lower is Blue.

Show all：Show maxilary and madibular

Show maxillary： Only show maxillary

Show mandibular：Only show mandibular

Close mode：Show close model

Open mode：Show open model

Front view：Orients the front

Back view：Orients the back

Right view：Orient right

Left view：Orient left

Top view：Orient above

Bottom view：Orietnt below

Gallary：Show 6 models side by side

Mesh：Show in mesh

Slide：Show overjet/overbite

Length：Mesure the distance

Angle：Measure the angle

About model toolbar
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Rotate model in the direction respectively.

 Gallary

Click it and show 6 models side by side. If you click again, 
restore to its original view.

 Mesh

Click it and display models in mesh. If you click it again, 
restore to its original view.

 Slice

Display overjet/overbite to click this tool. Click it 
again when you finish it.
 Adjust the slice location with scroliing mouse wheel 
when you confirm how you want to display the 
little dental model with slice. You can measure the 
distance of overjet/overbite with the "Length" tool. If 
you click again, restore to its original view.

In slice mode, Shift+Scroll up or down to shrink or 
enlarge models.

 Length

Click it and put two points as you like with Ctrl+left 
click. And then, the distance between these two 
points appears.
You can measure the distance many times. Exit to 
measure the distance to click the "Lengh" tool again.

 Angle

Put three points as you like with Ctrl+left click, 
and the angle among three points appears. You 
can measure the angle many times as well. Exit to 
measure angle to click the "Angle" tool again.
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15. Make analysis by 
yourself!

　

15-1 User analysis definition

Let us try to analize of ourselves.
You can adopt  User1, User2, User3 and User4 (all of 
this four) for a lateral, a frontal and trace of a submen-
tovertex...
 Analysis to define a user exchanges a combination 
of analysis that there is already, and one analysis can 
gather up necessary measurement item.

 Analysis of User4 defines necessary measurement 
point by researches newly and can analyze it.
As for you, a screen, print can define display segment 
of a line to output.

 A measurement defines the data which are input al-
ready even if the re-input of X-rays film is not done in 
order to collect the statistics, and new data are pro-
vided.
Because User4 can do point addition, attention is 
necessary for data handling.
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In case of lateral, analysis to have on of user define is 
four analysis of Tweed, Roth, User3,  User4.

15-1-1 A definition of analysis name

For first you name your analysis please.
And select analysis name of emphasized user define 
of shadow character among analysis menu:
You select Tweed or Roth or User 3. Because check 
mark appears before a name of analysis, you under-
stand it which was selected. You try to select Tweed 
for trial here.
All the changes in the future are done for Tweed anal-
ysis.

By define menu, you select a define of analysis name next 
and type 'Green' (you do not mind by a name of yourself) 
and click OK button.
 It is assumed drag by a menu of analysis, and Green analy-
sis is listed with Ricketts, Steiner in the same way, and 
graphics display of every time 'Green' and a measurement of 

Table 1			    Inputed lateral analysis 32 points

No. name		  Input analysis point
 0. Sella			   : A constructed point in the middle of the sella turcica.
 1. Porion		  : Most superior point of external auditory meatus
 2. Basion		  : Most inferior point of external auditory meatus
 3. Hinge Axis		  : Hinge of Condyle
 4. PT-point		  : The junction of the pterygomaxillary fissure and the formmen rotundum
 5. Naison		  : 'V' notch of frontal and nasal bone
 6. Orbitale		  : Most inferior point of the orbital contour
 7. Point-A		  : Deepest point between ANS and the prosthion
 8. PM			   : Point where curvature changes between B-point and Pogonion
 9. Pogonion		  : Most anterior point of the symphysis
10. Point-B		  : Deepest point between Pogonion and the lower incisal alveolus
11. PNS			  : Tip of the Posterior Nasal Spine
12. ANS			  : Tip of the Anterior Nasal Spine
13. R1			   : Deepest point on the curve of the anterior border of the ramus
14. R3			   : Most inferior point of the sigmoid notch of the ramus
15. Articulare		  : Intersection of inferior cranial bas 〜 surface and posterior surface of condyle
16. Ramus		  : Lower point of a tangent of the posterior border of the ramus
17. Corpus		  : the point of a tangent of the inferior border of the corpus; mandibular plane left
18. Menton		  : Most inferior point on the synphyseal outline
19. mx1 Incisor superius 	 : Tip of the crown of the upper incisor
20. mx1 apicale Incisor 	 : Root apex of the most anterior maxillary central incisor
21. md1 crown 		  : Tip of the crown of the mandibular central incisor
22. md1 root		  : Root apex of the most anterior mandibular central incisor
23. Occlusal plane	 : Midpoint between upper and lower first bicuspid, or upper and lower incisor
24. mx6 distal		  : Distal contact point of maxillary first molar 2mm above occlusal plane
25. mx6 root		  : Distal buccal root of maxillary first molar
26. md6 distal		  : Distal contact point of mandibular first molar 2 mm below occlusal plane
27. md6 root		  : Distal root of mandibular first molar
28. Gnathion		  : on the born Gnathion, gnathion is the point of intersection of these two planes.
29. Gonion		  :on the born Gonion, A constructed point, the intersection of the lines tangent 		
			    to the posterior margin of the ascending ramus and the mandibular base.
30. Condylion (Co)	 : It is the most superior point on the condylar head.*
31. PAC			  : Dr.Kim's PAC,use for ODI, APDI palatal plane instead of ANS-PNS palatal 		
			    plane.
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Table 2

No.	 A measurement point got by a calculation

  -1	 Nasion perpendicular
  -2	 A-point perpendicular
  -3 	 Right point of Tweed triangl
  -4	 R2  (Ricketts)
  -5	 R4  (Ricketts)
  -6	 Xi-point (Ricketts)
  -7	 constructed Gonion
  -8	 DC-point  The point in the center of the condyle neck along the Ba-Na plane (Ricketts)
  -9 	 intersection, line from #1 to #6 with #5 to #7
-10	 occlusal plane, right
-11 	 constructed Gnathion
-12	 occlusal plane, left
-13 	 lowest pt. of Pterygoid Vertical (perp.)
-14 	 CF (Pterygoid Vert- Frankfurt Horizontal) (Ricketts)
-15	 CC (Nasion Basion - Facial Axis) (Ricketts)
-16	 mid molars (between distal contact points)
-17 	 intersection, line from palatal pl.(#12 to #11) with mand. pl.( #18 to #17)
-18 	 intersection, long axis of mx1 and Sella-Nasion
-19	 intersection, long axis of md1 with mandibular plane
-20	 Sella minus sseven degrees (Burstone)
-21 	 EN pronasale, tip of the nose
-22	 G Glabella
-23	 Sn Subnasale
-24	 upper lip
-25	 stomion superius - upper embrasure
-26	 stomion inferius - lower embrasure
-27	 lower lip
-28	 soft-tissue pogonion (DT)
-29	 soft-tissue Menton
-30	 soft A-point ( superior labial sulcus )
-31	 soft B-point ( inferior labial sulcus )
-32	 soft tissue Nasion
-33	 soft Nasion perpendicular
-34	 intersection of line lower lip-Pogonion and FH(Tweed)
-35	 intersection of line upper lip-Pogonion and FH(Tweed)
-36	 A-point projected to the occlusal plane(WITS)
-37	 B-point projected to the occlusal plane(WITS)
-38	 intersection, line from SN(#0,#5)with posterior ramus pl.#15 to #16
-39	 defined
-40	 Point of 5mm right side of mid molars (-16)
-41	 Mx1 to FH, line from #19 to #20 with #1 to #6
-42	 A-B.to ANS-PNS, line from #10 to #7 with #11 to #12
-43	 A-B.to Mand., line from #7to #10 with #17 to #18
-44 	 defined 	
-45	 Tweed Triangl left ( FH to Mandib. Pl )	
-46 	 inter section Mand. pl to Occlusal pl	
-47 	 inter section E-line to Occlusal pl	
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Green analysis get when you click 'Green' from now on.

　　

A position of input lateral analysis point
 Point number of the input order is different.
Point number of analysis point to use with user define refers 
to a number of a another table.

Parameter 1-4

You name a measurement it

you select a kind of measurement You input a norm

Designation of the 
display place

You can refer to other analysis

You can indicate contents when 
push a copy

It moves by measurement 
item number

Measurement item number Change volumes of a norm

You push change 
button certainly

Number of measurement item

You input 1-8

Measurement item setting dialogue
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15-2 Definition of 
measurement item

15-2-1 A define of measurement item
 As to Analysis point and measurement point you area re-
quested to input a number respectively from among 0 〜 31 
and -1 〜 -47 instead of name of a point in order to define a 
measurement.  These numbers are assigned to each analysis 

Table3　Kind table of measurement

Measurement		 Parameter １	 Parameter ２	 Parameter ３	 Parameter ４

Point to Point（Figure1）		 1st Point		  2nd Point	 	 not use		  not use

Point to Line（Figure2）		 Point						      not use

P. to P. parallel to Line（Figure3)		 1st Point		  2nd Point				   End point of straight Line

P. to P. perpen to Line（Figure4）		 1st Point		  2nd Point				   End point of straight Line

Angle ＊ 1（Figure5）								     

Angle- 90dg（Figure6）						   

Area ＊ 2（Heron's Formula)（Figure7）		 1st Point	 	 2nd Point		 3rd Point		  （4th Point）

Area ＊ 3（Area among line）（Figure8）	  		  not use		  not use		  not use

		
#1 - #2		 Measurement １	 Measurement ２	 not use		  not use

#1 + #2 + #3 + #4 		 Measurement １	 Measurement ２	 	 	

#1* 100 / #2		 Measurement １	 Measurement ２	 not use		  not use

1: #1 / #2 		 Measurement １	 Measurement ２	 not use		  not use

Calc.						     constant value	 not use

Header		 Header can insert an explanatory note and prose in a list without measuring it.

Formula	 	1 〜 8（You cannot change the calculation definition of Procedure. It is supported by us.）

Manual Input	 Manual Input can input arbitrary numerical value.

　Calculating formula reads Procedure (1-8).Seven Procedure is offered now. If there is a demand, it may be added.
Procedure １（Undefined）	 x=Calculation １*0.4+Calculation ２*0.2-35.16 (Reference）

Procedure ２（Cagliari ）	 x=Calculation １-(Calculation ２/Calculation ３)

Procedure ３（Tweed Z angle）	 The small angle of the angle with the FH plane of each tangent lines from Soft pogonion to 

Upper lip and Lower lip.

Procedure ４（ODI ）	 Dr. Kim's ODI

Procedure ５（APDI ）	 Dr. Kim's APDI

Procedure ６（CF）Combination factor	 Dr.Kim's CF、CF=ODI+APDI 

Procedure ７（EI ） Extraction Standard	 Dr.Kim's Extraction Index = ODI + APDI -( 130-Interinsaisal ) / 5 - Lower-Lip - Upper Lip

Procedure 8（Adjusted ANB）	 ANB revision of Freeman	

*1  Important：When you calculate an angle, a mark of the measurement value is reversed or, in the case of the thing 
which an angle does not expect, replaces a parameter.( Parameter 1 ⇄ 2, 3 ⇄ 4 )When it is predicted that measurement 
values exceed 180 degrees, please use a supplement.
*2 The Heron's formula calculates an area surrounded with three points. However, it calculate the area of the irregular 
quadrilateral when you input the fourth point.
*3Input the number of the line after the fifth which you input in a line into parameter 1.The number of the line is as 
follows. 0:Upper profile Line　1:Lower profile Line　2:Mandibular Line　3:Maximally Line　4 〜 :Line
When the line traces it clockwise, the area  becomes plus value when you trace it counterclockwise, it becomes  
minus value.

Note：measurement １、measurement ２、measurement ３ are the number of the measurement item of the measurement 
result.

1 〜 4
（1: × 2: ÷ 3:+ 4:-）

Initial point of 
straight Line

Initial point of 
straight Line

Initial point of 
straight Line

End point of
 straight Line

Initial point of 
the first Line

End point of
the first Line

Initial point of
the second Line

End point of 
the second Line

Initial point of 
the first Line

End point of
the first Line

Initial point of
the second Line

End point of 
the second Line

Line No.
（After the 4th）

Measurement ３
（or not use）

Measurement ４
（or not use）

99   ( measurement 
number  #99 )
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Point to Point Point to Line

P. to P. parallel to Line P. to P. perpen to Line

Angle
Angle- 90dg
90dg- Angle

Area (Heron's Formula) Area (Area among line)

Ao-Bo etc
Over jet

Over bite

Figure 1 Figure 2

Figure 3 Figure 4

Figure 5 Figure 6

Figure 7 Figure 8
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Point to Point（Figure 1）
  Distance between two points.

Point to Line（Figure 2）
  Distance from a point to segment.

P. to P. parallel to Line（Figure 3)
  Distance between the two points which are parallel to  
segment.

P. to P. perpen to Line（Figure 4）
  Distance between the two points which are perpendicular to  
segment.

Angle（Figure 5）
  An angle between two segments.
  Important：When you calculate an angle, a mark of the 
measurement value is reversed or, in the case of the thing 
which an angle does not expect, replaces a parameter.
( Parameter 1 ⇄ 2, 3 ⇄ 4 )When it is predicted that 
measurement values exceed 180 degrees, please use a 
supplement.

Angle- 90dg（Figure 6） 
  Subtract 90 degrees from an angle.

90dg- Angle（Figure 6）
  Subtract an angle from 90 degrees.

Area (Heron's Formula)（Figure 7）
  The Heron's formula calculates an area surrounded with 
three points. However, it calculate the area of the irregular 
quadrilateral when you input the fourth point.

Area (Line)（Figure 8）
  Input the number of the line after the fifth which you input in 
a line into parameter 1.The number of the line is as follows.
0:Upper profile Line　1:Lower profile Line　2:Mandibular 
Line　3:Maximally Line　4 〜 :Line

#1 - #2
　Subtract a measurement item from the measurement item.
Ex:SNA-SNB=ANB

 #1 + #2 + #3 + #4 
　Add a measurement item and a measurement item.

#1* 100 / #2
　（＃１measurement item ÷＃２measurement item ）X　100
　　（％）

1: #1 / #2
　（＃１measurement item ÷＃２measurement item）　0.00 〜
1.0

Calc.
　Constant is multiplied, divided, added, and subtracted from 
the measurement item.
　Parameter 1：measurement item
　Parameter 2：Input 1-4( 1: × 2: ÷ 3:+ 4:- ）
　Parameter 3：Input the fixed number

Header　
  Header becomes an annotation and a blank line that the 
measurement item doesn't enter. Annotation of group of 
analysis such as Skeletal,Denture,Soft tissue etc.

Formula
Procedure 1-8 are defined internally. In the frame at the right 
of the calculating formula, number (1-8) of the procedure is 
input. 
Following calculation 1, calculation 2, and calculation 3 are 
the numbers of the measurement item input to parameter 
1-3. 

Procedure １ x=Calculation １*0.4+Calculation ２*0.2-35.16
　　　　　　 ANB Revision=SNA*0.4+SNB*0.2-35.16
Procedure ２（Cagliari ）
　                 x=Calculation １-(Calculation ２/Calculation ３)
Procedure ３  (Tweed Z angle）
 The small angle of the angle with the FH plane of each 
tangent lines from Soft pogonion to Upper lip and Lower lip.
Procedure ４  (ODI ) Dr. Kim's ODI
Procedure ５  (APDI ) Dr. Kim's APDI
Procedure ６  (CF) Dr.Kim's CF、
                    CF=ODI+APDI 
Procedure ７ (EI) Extraction Standard　Dr.Kim's Extraction 
Index = ODI + APDI -( 130-Interinsaisal ) / 5 - Lower-Lip - 
Upper Lip
Procedure ８（Adjusted ANB）ANB revision of Freeman

Manual Input
　Input the numerical value that I cannot measure from 
X-rays into the weight or height. You can find "Height and 
S-N distance" and "the coefficient of correlation of the ANB 
angle".

◎ Explanation of kind of measurement
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point, measurement point.

Attention: You do not seem to confuse a number of analysis 
point of the input order at inputting a number of measurement 
measurement point at defining it and trace of Chapter 4 and 
do it.  A number of a measurement point inputs analysis 
point input from direct trace by a positive number in case 
of measurement define.  The measurement point that it was 
calculated from input analysis point, and was defined inputs it 
by a minus. A number and a position of a measurement point 
are indicated in a figure.

  You can use all measurement points got by input 32 analy-
sis point and calculation of 47 in order to make analysis of 
oneself. You use these analysis point and a measurement 
point and can define a measurement of the greatest 60 
items.

15-2-2 Practice of item define

You start it by selecting 'Tweed' analysis by analysis menu in 
order to define a new measurement value.  You select define 
'of' analysis item by define menu next.  Dialog box of defini-
tion of analysis item appears.  You use this dialog box and 
can define measurement item of maximum 60.

Analysis item number (No. 1), measurement name is indi-
cated by leaning to the left of screen.  There is the round 
button which seems to be added to the 12 radio which can 
be checked with a mouse under. There is each it for the cor-
respondence to measurement contents of ten different types.  
Those each is explained from figure 1 figure 10.  There are 
four parameter input boxes (1-4) in the left side.

 Please watch definition contents of measurement of Tweed 
before defining a measurement of oneself. You can watch to 
click  ( previous) (next)  button on the right of screen.  15 
measurement values are registered in Tweed already.  It is 
established whether it is how many registered by number of 
analysis item under a screen (60 or less).
 For example, measurement number No. 1 is defined as 
angle measurement of ANB. ANB is an angle between two 
segments of a line of a segment of a line which connects 
segment of a line and Nasion ( # 5) and Sella ( # 0) to tie 
Point-A ( # 7) to with Nasion ( # 5).

First (next) you push a button and proceed measurement 
number to No. 16 to add Facial angle ( Facial depth angle ) 
here.
All the contents of dialogue box of measurement definition 
become a blank.

You name a measurement it
You input a new name of measurement item into title box. 
You input it with Facial angle.

You select a kind of measurement
Because a kind of measurement is angle measurement, a 
check of radio button clicks an angle.

The input of parameter 1-4
You establish a parameter while referring to a table of analy-
sis point.  Table 3 are explanation of parameter to define a 
measurement of analysis.  A number of analysis point refers 
to table 1, table 2.

You input a number of a point of both ends of the first seg-
ment of a line.
　(in a box of parameter 1 and 2 , 5 and 9)　
You input a number of a point of both ends of the second 
segment of a line next.
　(in a box of parameter 3 and 4 , 6 and 1)
It is possible to define an angle by inputting it.

A measurement name 		      :  Facial angle
radio button			       :  Angle
Segment of a line 1	 Parameter 1: 5（Nasion）
			   Parameter 2: 9（Pogonion）
Segment of a line 2	 Parameter 3: 6（Orbitale）
			   Parameter 4: 1（Porion）

Input a norm
You need to input a norm into a measurement value.
You input a value provided as a result of study of a user 
whether a value of a norm depends on literature.As a norm, 
you have  defines according to each race of Westerner, 
Oriental,Latin or Black. Because Tweed analysis does not 
compare it with a norm, a column of a norm is turned into 
blanks. The next standard age, change volume between 
years, a value of standard deviation do not input it when you 
do not input a norm.You push TAB key in order to go along 
from a box to a box.

In this place
		  White men	 :86.5
		  Japanese	:86.0
		  Latin		  :88.0
		  Blacks		  :86.2
You input as it.

Input standard age and change volume between years (a 
growth rate)
 You input the year change volume thought that the age that 
a norm is applied and a norm change with growth.  If a norm 
does not change by growth, you will turn a box into a blank.

Input standard deviation
  You input standard deviation in order to validate a norm.   
There is a norm 4 according to a race, but can input only 
one standard deviation.  You input standard deviation value 
for a racial norm to utilize most.

Input display position of measurement value on trace
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　You can indicate a measurement value on trace.　A value 
measured by the value that let you in these three boxes of 
the display place, x direction and y direction decides a posi-
tion output by a screen and trace of print.
　When a measurement value (No.16 SNA) wants to indicate 
it near a point of intersection of FH plane on trace and Na-
sion and Point A, you input it with thought, display place -9.
You input it as follows in order to show the position that 
moved to X, Y direction it.

   The display place  -9　 (intersection #1-#6、#5-#7)
   X direction 　	 -12　（ the place to -12 mm）
   Y direction 　	   -8　（ the place to -8 mm）

 This indicates a value in 8 mm the left to a place of 12 mm 
to the lower part of analysis point of -9. Positive number of 
X direction is indicated here by the right direction of analysis 
point. Negative number is indicated by the left direction of 
analysis point. Positive number of Y direction is indicated on 
analysis point here by a direction. Negative number is indi-
cated under analysis point by a direction. A unit of X and Y 
coordinate is mm. You turn a box of the display place into a 
blank when you do not want to indicate a measurement value 
in trace.

Register changed contents
 You click a button (Change) and register measurement value 
No. 16.  This stores measurement value No.16 defined in 
C.O.I.INFO file newly. You click a button (next) if you want to 
still add it and go to measurement value No. 17.

Change of number of analysis item (60 or less)
Because you added it  one to an item defined already, you 
change analysis item (60 or less) in 16.

Register changed contents
You click a button once again (a change) and register 
yourself. This saves number of analysis item registration in 
C.O.I.INFO file. Facial angle of No. 16 that was registered 
itself with when number of analysis item was 15 is not indi-
cated.

An end
You click a button (End) and are finished.

15-2-3 Copy a measurement from 
other analysis

 You search measurement define of analysis used already (Soft 
Tissue analysis is excluded) and copy it and can use it in or-
der to reduce work of a define of measurement.  You will turn 
analysis item into a copied number.
 There are five buttons in the left lower part of dialogue win-
dow.
    (previous) (next) analysis name
 You click the previous, the next button in order to select 
analysis name considered to want to call it.

   (previous) (next) the measurement item name
 You click the previous, the next button in order to select a 
measurement value in the analysis.
   (copy)
 It copies contents.

You move to the input place with a mouse and input it when  
want to change contents.  Please do not forget that you 
push a ( Change ) button in order to save.

15-2-4 A definition of a segment of a 
line

 You define a segment of a line as facial plane or FH line as 
an additional line freely, and trace can indicate it. You select 
a define of display segment of a line by define menu in order 
to define a line of trace.  Dialog box to define a line of trace 
of Tweed analysis that is to be shown in the following ap-
pears.
 As for Line # 1 ,0 (Sella) and 5 (Nasion) that is SN plane is 
defined. Number of a segment of a line is 11.
 You click the (next) button if you add it and register with the 
twelfth. You can pass the line which was defined by default 
by clicking ( next) or (previous). You input two numbers of 
a point that want to define a segment of a line. You click a 
Change button after having defined it certainly.You click (next) 
afterwards.  It can define a segment of a line to maximum 25 
segment of a line.
 You input number of a line if [subj] defined all segment of a 
line. It is not indicated when you will not enter with 15 if de-
fined 15 segment of a line in all.  You click a Change button 
after the input certainly.

  

You click END button in order to finish an editing for segment 
of a line define.

15-2-5 Characters on a trace

The original analysis definition allows to display the analysis 
item names on a trace.

Operation

Select the original analysis on the used analysis menu.Select 

the "Define Strings" on the definition menu.
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Input the chracter strings to display, and input a measure 
point number in a indcation location box, and the distance 
from the pointi in each X & Y axial direction boxes. Click the 
change button to register. Note that inputting the data is not 
enough to register, you should click the change buttonto 
register.

   
Click the next button to continue. When the all input of 
strings have done, register the number of items: ex. Register 
"3", when you define three character strings. If you don't 
register it, the character strings doesn't appear.
Click the done button finally.

15-3 Analysis definition of 
User4

  When you want to analyze your original new measurement, 

there would be a case where you need another analysis 
points  added. So  It is possible here to define an arc as a 
function and add some more analysis points using only this 
User4.   Analysis definition with this User4 is an analysis that 
a user can add analysis points additionally..  It is possible 
to add 40 points of analysis points by analysis of User 4.  A 
procedure to define a definition of analysis name and a mea-
surement is same as contents described the above.

 For example, a definition adds some measurements point 
newly to do Sassouni analysis used with surgery orthodontics 
well.
   And it is segment of a line indication of trace by Sassouni 
analysis, and a display of arc is necessary, but it is possible 
to define an arc.

15-3-1 Definition of addition point

  Except analysis point decided already, you can define addi-
tion of new analysis point.
  You can define analysis points from 60 to 99 with point de-

fine of define menu newly. Shown as follows, and dialog box 
appears.
・You input a name of new analysis point into name box.
・You click change button certainly.
・You click the next button and input a name of next point.

 

  You click a button previous or next to move to other analy-
sis points.The additional analysis point is 40 points where 
can be registered itself with begins from No. 60 to No. 90.  
As for the number of each analysis point, number is indicated 
by the top of dialog box.

 You input  number of analysis point (59 or more 99 or less) 
after a name of each point was defined.  In case of 59, it 
judges that there is not additional analysis point. You input 
right number and click change button certainly. Number of 
analysis point is not stored so.  You click end button when 
over in order to go out of analysis point addition editing.

15-3-2 Definition of a point to demand 
by a calculation

  In a define of a measurement point of define menu, a user 
can define a center of gravity or a measurement point of 
points of intersection by a calculation from an input point 
newly.
 60 measurement point to demand by a calculation from No. 
-1 to No. -60 is reserved by a system. A user defines it 39 
points from No. -61 to No. -99 and can use it.

 Procedure  is alike with a define of analysis item of define 
menu with Chapter 7,2-2 well.  You select analysis of User 4 
of analysis menu with a mouse.  And you select a define of 
a measurement point of define menu.  Dialog box as follows 
appears.

  There are five calculation methods. These detailed figures 
are shown with figure E from figure A of the following pages.
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   You click next or previous button till a measurement point 
to demand by the calculation that wants to be changed ap-
pears.　You click one radio button. You click change button 
certainly after you input point numbers, and having defined it.  
nd you continue a define with the next button. 
  If making of all calculated measurements point was finished, 
you input number of total into a box of number of a measure-
ment point to demand by a calculation (60 or more 99 or 
less). Attention: Number of 59 or less must not input it.

  You push change button certainly and enter after the input.
You click end button and are finished.

A measurement point of -61 or more -99 is usable by this.

About five calculation methods

    

Figure A

　      Figure A parallel movement   Point Q  
          P1, P2 are measurement points    P3, P4 are distance

Parallel movement (figure A)
  A new measurement point (point Q) is the position where 
P3 (distance) moved to x direction from measurement point 
P1 (x coordinate).
and the position where P4 (distance) moved to y direction 
from measurement point P2 (y coordinate).  A unit of dis-
tance is mm.
 
 You input a number of a measurement point (#) into P1 and 
P2 of a box.  You input a value of an offset of x direction 
and y direction into P3 and P4 of a box.  X axis, the right of 
horizontal direction is positive.  Y axis, the upper of vertical 
direction is positive .

    

Figure B

      Figure B Gravity    Point-Q are centers of gravity  P1, P2, P3, P4, 

A center of gravity of a point   (figure B)

 New measurement point (point Q) is the center  of gravity of 
measurement point P4 from  point P1. It adds all coordinate 
value, and it is calculated by dividing it by number of a point.

 Coordinate x and y of new point Q, It is defined by
	 x=(x1+x2+x3+x4)/4　
	 y=(y1+y2+y3+y4)/4
 You input a number of a measurement point into P4 from P1 
of a box.  You input 'no' into parameter P3 or P4 when you 
get two points or three points of centers of gravity.

    

Figure C

　　　Figure C Intersection  Point Q 
         segment of a line P1-P2, segment of a line P3-P4

A point of intersection (figure C)

  A new measurement point (point Q) is a point of intersec-
tion of two segment of a line.  In other words point Q is a 
point of intersection of segment of a line P1-P2 and segment 
of a line P3-P4.  You input a number of a measurement point 
into parameter box.

107
YASUNAGA Computer Systems Co.,Inc.



    

Figure D

　　  Figure D  Parallel point point Q 
                      Segment of a line P2-P3  P1 measurement point

A parallel point (figure D)

  A new measurement point (point Q) is the position where 
distance between P2 and P3 and same distance moved to 
from P1 on a segment of a line which went through P1 in 
parallelism in segment of a line P2-P3.  In other words, it 
makes parallelogram P1, P2, P3, Q with these four points.  
You empty unused parameter box P4.

 

Figure E

　　　Figure E  Perpendicular line  Point Q  P2-P3 is a segment of a line
           P1 is measurement point

A perpendicular line (figure E)

  A new measurement point (point Q) is a point of 
intersection of a perpendicular line with segment of a 
line P2-P3 from measurement point P1. You input a 
number of a measurement point into parameter box 
P1, P2, P3.  You empty unused parameter box P4.
　

15-3-3 A definition of an arc

  You can define a display of maximum eight arc for 

Sassouni analysis.  You define starting point P2 of 
arc (a measurement point) and terminal P3 of arc 
(a measurement point) as center P1 of rotation that 
is to be shown with figure F (a measurement point).  
An arc is from a starting point to a terminal on the 
second radius segment of a line.

 You select a define of an arc of define menu. The 
following dialog box appears. Three analysis points 
of an input or calculated measurement point input 
a number of the center of arc, a starting point and 
a terminal. After the input, you click change button 
certainly.

You input number of arc if  finished a define of an 
arc.
After the input, you click change button certainly.
You click end button, and please be finished.

   

Figure F

　　Figure F　A display of an arc
      P2 is a start of arc, P3 is terminater point of a corner, P1 is the center of 
rotation

15-4 To return to original 
Tweed analysis
  You did define, but can change it back into a default in 
we shipment when you want to still replace it by copying 
original C.O.I.INFO.
  Please consult me when you do not understand it with 
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point define of a define of analysis, a define of a measure-
ment point, a define of analysis item, a define of display 
segment of a line, a define of an arc.

15-5 Analysis definition of a 
frontal
A frontal defines analysis as a lateral in the same way, too 
and has point addition on.

15-6 Analysis definition of a 
submentovertex
A submentovertex defines analysis as a lateral in the same 
way, too and has point addition on.

Table 4

33 measurement point for frontal analysis

No.   Name		  Explanation
  0.　crista Galli		  Cg crista Galli
  1.　condylion  left	 most superior aspect left
  2.　condylion  right	 most superior aspect  right
  3.　zygomatic suture right	zygomatic Bilateral points on the medial margin of the zygomatico-frontal suture,
			    at the intersection of the orbits.
  4.　zygomatic suture left	 zygomatic frontal suture at intersection of orbits left
  5.　zygomatic arch right	 zygomatic center of the root of zygomatic arch mid-points, right
  6.　zygomatic arch left	 zygomatic center of the root of zygomatic arch mid-points, left
  7.　nasal cavity right	 point on the outline of the nasal cavity at the widest area in frontal perspective right
  8.　nasal cavity left	 nasal cavity at the widest area left
  9.　jugular process right	 intersection of zygomatic buttress and outline of tuberosity right
10.　jugular process left	 intersection of zygomatic buttress and outline of tuberosity left
11.　antigonial notch right	 point at lateral inferior margin of the antigonial protuberances  right
12.　antigonial notch left	 left
13.　anterior nasal spine	 tip of anterior nasal spine just below the nasal cavity and above the hard palate
14.　menton		  point on  inferior border of symphysis directly inferior to mental protuberance 
			   and below center of trigonium mentali
15.　right mx 6 crown	 most buccal point at molar crown
16.　right mx 6 root	 tip of buccal root of molar
17.　right mx 1 crown	 midpoint of incisor edge
18.　right mx 1 root  	 tip of incisor root
19.　left mx 1 crown	 midpoint of incisor edge
20.　left mx 1 root		  tip of incisor root
21.　left mx 6 crown	 most buccal point at molar crown
22.　left mx 6 root   	 tip of buccal root of molar
23.　left md 6 crown	 most buccal point at molar crown
24.　left md 6 root   	 tip of buccal root of molar
25.　left md cuspid crown	 tip of cuspid crown
26.　left md 1 crown	 midpoint of incisor edge
27.　left md 1 root	 tip of incisor root
28.　right md 1 crown	 midpoint of incisor edge
29.　right md 1 root 	 tip of incisor root
30.　right md cuspid crown	tip of cuspid crown
31.　right md 6 crown	 most buccal point at molar crown
32.　right md 6 root	 tip of buccal root of molar
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Table 5

25 points that were defined for frontal analysis define

	   -1:   perpendicular from ANS to ZL-ZR plane
	   -2:   perpendicular from ANS to ZL-ZR plane ( menton )
	   -3:   perpendicular from Co-Left to Cg-ANS Line
	   -4:   perpendicular from Co-Right to Cg-ANS Line
	   -5:   perpendicular line from ZL to Cg-ANS Line
	   -6:   perpendicular line from ZR to Cg-ANS Line
	   -7:   left molor (#15-#31 ) mid point ( occlusal left ) 
	   -8:   right molor ( #21-#23 ) mid point ( occlusal right ) 
	   -9:   intersection of occlusal plane and Frontal facial plane left
	 -10:   intersection of occlusal plane and Frontal facial plane right

111
YASUNAGA Computer Systems Co.,Inc.



	
	 -11:   perpendicular line from left mx6 crown to occlusal plane
	 -12:   perpendicular line from right mx6 crown to occlusal plane
	 -13:   perpendicular line from left md6 crown to occlusal plane
	 -14:   perpendicular line from right md6 crown to occlusal plane
	 -15:   upper incisor( #17-#19 ) mid point
	 -16:   lower incisor( #28-#26 ) mid point
	 -17:   perpendicular line from ME to Cg-ANS line
	 -18:   perpendicular line from ZA to Cg-ANS line
	 -19:   perpendicular line from AZ to Cg-ANS line
	 -20:   perpendicular line from NC to Cg-ANS line
	 -21:   perpendicular line from CN to Cg-ANS line
	 -22:   perpendicular line from JL to Cg-ANS line
	 -23:   perpendicular line from JR to Cg-ANS line
	 -24:   perpendicular line from AG to Cg-ANS line
	 -25:   perpendicular line from GA to Cg-ANS line
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Table 6

14 measurement point for submentovertex analysis

  0.   Pogonion
  1.   Foramen spinosum right
  2.   Condylion lateralies right
  3.   Lilian point right
  4.   Right maker rod
  5.   Gonion right
  6.   Condylion mediais right
  7.   Odontoide
  8.   Left marker rod
  9.   Condylion lateralies left
10.   Lilian point left
11.   Condylion mediais left
12.   Gonion left
13.   Foramen spinosum left
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15-7 Recording of voice
Macintosh:

 You edit it and can register a sound at inputting a point with 
a voice of user confidence.

 A sound is registered with C.O.I.Sound file.  You will take 
backup before doing sound editing.

 You use sound of define menu. In shipment, a lateral, a 
frontal, a sound of each analysis point of a submentovertex 
are registered.  You click Try button to check a sound.
A Sella and a sound do it in an example of lower part.
You can see you off with the next button successively.

　　　

 You will try to put a real sound next.  You click radio button 
of lateral frontal model submentovertex of sound editing for 
the purpose.  You select analysis point with the front and the 
next button.  You try to check actually, what kind of sound is 
registered with the try  button.
The following dialogue is indicated when you click sound ed-
iting button.

	

Loud speaker mark changes by size of voice when you sends 
in a voice toward computer attached microphone.  You push 
recording button and tape it.  You stop temporarily when you 
push recording button once again.  You push play button 
and confirm contents.  You push save button if good and en-
ter.

 It returns in a dialogue of a point.
 You confirm it with Try button.
 You push sound editing when you want to do sound editing 
sequentially and can follow.  You end recording of voice with 
end button when you want to be finished.

 Windows version: please read instructions of SoundBlaster 
of Windows.
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